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ABSTRACT

This guide contains information, curriculum, and activities
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using Netscape Navigator, directory of educational resources on the Internet,
downloading information, and information to access keyboarding and accounting
shareware. The next 11 sections contain activities in these areas: education
trends and issues; economic indicators; consumerism; communication; resume
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search; stock exchanges; Chicago Board of Trade; New York Stock Exchange
News; stocks; business travel; SAP (Systems, Applications, and Products in
data processing) software supply; office furniture; human resources;
management; selling; Internet; technological issues; and telecommunications:
technology. Each activity has some or all of these components: purpose, time
required, directions, steps for using the Internet, and handouts. The next
section provides information on Virtual Economics, a CD-ROM designed to give
teachers the resources they need to help students at all grade levels
understand the economy and develop basic decision making skills while
learning to use interactive, multimedia technology that promotes higher-level
learning. Contents include framework questions to give teachers a refresher
on economic concepts or to use with students and extended activities. The
final section provides information on PowerPoint presentation software for
creating and presenting slides. (YLB)
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INTRODUCTION
The Multi-Media and Technology Tools Curriculum Guide was developed at the University of
Idaho with the support of a grant from the Idaho Division of Vocational Education.
Technology changes so rapidly that we are well aware that what appears on home pages and the
existence of home pages fluctuates frequently. Our experience is that they continue to provide
more information is a more user friendly environment as they become more sophisticated and
valuable in your search for and use of information.

Virtual Economics is a CD-ROM designed to teach Economics to public school students for
post-secondary students and adults. More specific information about Virtual Economics appears
in that section of this guide.
Economics is an important component of business and marketing education and we encourage
you to integrate economic concepts into your curriculum as much as possible.
There are business oriented CD's available for sale but the real gold mine of information is on the
World Wide Web. Most of it is untamed and we have attempted to provide you with a tool for
using the WWW for enhancement of your business program. Good luck!
June 1996

Marty Yopp, Project Director
K. Allen Kitchel
Tacey Allen
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COMPUTER USE POLICY
Date:

(Please Print)

Student Name:

Acceptable Use. Policy for Computer Networks
Your child has requested access to the
computer network. This
access includes connections to computers through the Internet, which would connect your child
with educational resources all over the world.
Please read
's Use Policy with your child. In accepting an account,
your child accepts the responsibility of using the network in an appropriate manner. It is important
that you understand his/her responsibilities as well. Your signature indicating that you have read
and agreed to our Use Policy is necessary before an account will be issued.

I have read the Student Use Policy for Network Access at
and agree to use the school network in an appropriate manner.
student signature/ date

I have read the Student Use Policy for Network Access at
and give the school permission to issue an account to my child.
parent signature/ date
Student Use Policy for Network Access at
Introduction/Explanation of purpose:

On the school network and on the Internet, students and staff may participate in activities that
support learning and teaching.
With access to other networks and people around the world, you might have access to
information that may not be appropriate.
has taken measures to
prevent access to inappropriate information; however, we can not control all the information
available on the Internet. The school is not responsible for other people's actions or the quality
and content of information available. We trust our students and staff to know what is appropriate
and inappropriate. The following guidelines are intended to help you use the network
appropriately. If a student does not follow our use policies listed here, his/her privilege of using
the network may be withdrawn.
111

111
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Use Policy
1. At all times, the
Is it appropriate?

Standards must be followed: Is it safe? Is it kind?

2. At all times, your actions must take into account the rights of others.
3. Respect the privacy of other network users.

4. Do not use bad language, and do not send messages that violate the law or would be offensive
to another person.

5. Any use of
's network shall be for the exchange of information in
order to help a person's education and research.
6. Use your own software. It is against the law to copy other people's software. ONLY copy
shareware, freeware, or software marked public domain.
7. Do not spread computer viruses.
8. Change your password frequently.

9. Users of
systems shall avoid congestion of the networks and
interference with the work of other network users.
10. Do not damage any networks or any equipment or system forming part of a network. Do not
break or misuse anything in the computer room.
11. Most of the Internet cannot be used to advertise or make money. Only advertise in
appropriate areas of the Internet.
12. NEVER give out personal information such as your home address or telephone number. Use
the school's address instead, but not the school's phone number.
13. Be familiar with these rules and how to use the Internet before getting on-line. If you have any
questions about these rules, please ask your teacher so you can understand.
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On-Line Etiquette
1. Keep your messages short, to leave room for other messages.
2. Make your "subject line" as descriptive as possible.
3. Always include an introduction before your message.
4. When replying to a message, include some of the original message.

5. Always sign your name and tell where you are from. If possible, include your E-Mail address,
and if appropriate, different addresses.
6. Always acknowledge that you have received a document or file someone has sent you.
7. Check your mail once or twice a week if you are waiting for letters.
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8. Delete E-Mail once you have read it or save it on your disk.
9. Personal messages on conferences, bulletin boards and listserves are not allowed.
10. Any time you send E-Mail, proofread and edit it so that there are no mistakes.
11. Don't reveal other people's private matters.

12. Be careful when using sarcasm and humor. Without face to face communications your joke
may not be taken the way you meant it. ;-)

Etiquette for Listserves and Discussion Groups
1. Keep your questions and comments relevant to the focus of the discussion.

2. When replying to a message posted to a discussion group, check the address to be certain it's
going to the intended location (person or group).
3. When signing up for a group, save your subscription confirmation letter so you will know how
to UNSUBSCRD3E!
4. When going away for more than a week, unsubscribe or suspend mail from any mailing lists or
LISTSERV services.

Multimedia Fact Sheet
What is Multimedia?
Multimedia is the use of a computer to present and combine text, graphics, audio and video with
links and tools that let the user navigate, interact, create, and communicate.
Four essential components of multimedia:

Must be a computer to coordinate what you see and hear, and to interact with.
Must be links that connect the information.
Must be navigational tools that let you traverse the web of connected information.
Must be ways for you to gather, process, and communicate your own information and
ideas.

Why is it Important?
Multimedia is fast emerging as a basic skill that will be as important to life in the twenty-first
century as reading is now. In fact, multimedia is changing the nature of reading itself. Instead of
limiting you to the linear presentation of text as printed in books, multimedia makes reading
dynamic by giving words an important new dimension.

Multimedia is highly effective. As Computer Technology Research (CTR) reports, people retain
only:

20% of what they see
30% of what they hear
50% of what they see and hear
But they retain:

80% of what they see, hear, and do simultaneously
That is why multimedia provides such a powerful tool for teaching and learning.

How is it Changing the World?
Multimedia is redefining the communication system that forms a significant part of the
infrastructure of our society. A large number of corporate mergers and alliances are combining
the telephone, television, and personal computer into a mass market multimedia utility.
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Mergers and Alliances
Multimedia is fueling an unprecedented number of mergers among companies jockeying for
position in this fast-paced field. Examples are:

MCI and Jones Intercable
Southwestern Bell and Cox Cable
US West and Time Warner
Multimedia alliances are not limited to the United States.

Telecommuting
Multimedia is also changing our place of work. According to a Deloitte & Touche report,
telecommuting (working from home using computers, modems, and fax machines) accounted for
45% of all new jobs from 1987 to 1992. 1993 saw one million more people telecommute than
during the year before, marking a 15% increase in company employees who work at home during
normal business hours.

Home Shopping
Multimedia is changing how the world shops. Instead of wearing yourself out trekking from store
to store trying to find the size and style you like and then having to wait in line to pay for it,
teleshopping services let you shop from home.

Electronic Publishing
Multimedia is changing how we read newspapers by eliminating the need for the paper and
offering all the features of multimedia, including full-text search, graphics, audio, and video.

Mass Market Use of Information Services
The most strategic use of multimedia may be to help bring the public into the information age. In
a society that depends so much on processing information, what could be more important?
Multimedia relieves information overload and techno stress by engaging more of the senses.

Teaching and Learning
Electronic publishing is not the only way multimedia is changing how we teach and learn.
Textbooks are, in some cases, being replaced with videodiscs giving students the ability to interact
with what they are learning.
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Text
While it is possible to have multimedia without text, most multimedia systems use text because it
is such an effective way to communicate ideas and provide instructions to users. There are four
kinds of text:

Printed Text - appears on paper.
Scanned Text - printed text which is converted by a scanner into machine-readable
form.
Electronic Text - machine-readable.

Hypertext - text that has been linked.

Graphics
It has often been said that a picture is worth a thousand words. Multimedia lets you do this when
graphics are the object of a link.

Bitmaps
A bitmap is a picture stored as a set of pixels that correspond to the grid of dots on a computer
screen.

gi

Clip Art: Creating graphics by hand is time consuming. To save time, there are
extensive libraries of clip art that you can use in multimedia productions.
Digitized Pictures: Video digitizing boards let you connect a video camera, VCR,
Videodisc player, or live video feed to your computer and grab frames instantly
into bitmaps that can be used in multimedia applications.
Hyperpictures : Just as words can serve as triggers in a hypertext, so also can
parts of pictures. When.parts of pictures are used to trigger.multimedia events,
they are called hyperpictures.

Sound
There are three types of sound objects that can be used in multimedia productions:
Waveform Audio : An audio digitizer that can record any sound you can hear.
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CD Audio : Music CD's that fortunately are in computer addressable form.
MIDI - Musical Instrument Digital Interface : Provides a very efficient way of
recording the performance information required to play music.

Interactive Multimedia Merchandising
Anyone who shops has been frustrated by the time and effort required to locate a product you
want in the style, color, and size you need. How often have you been told that what you want is
out of stock?

Florsheim Shoes
If you are tall like the author, and have big feet, Florsheim's merchandising kiosk is a godsend. It
lets you shop for shoes by style, size, and color by touching the screen and following voice
instructions.

MusicWriter's NoteStation
The music printing industry is taking advantage of multimedia computers to solve one of the
greatest problems facing music retailers: stocking sheet music. Instead of the problems of
maintaining inventory and high overhead, you can now use the MusicWriter's NoteStation to
search for music and purchase it by printing it out from the computer.

Video Merchandising
Blockbuster and IBM extended this merchandising concept to include video as well as audio.
They have produced a working model of interactive sales kiosks that will allow customers in
Blockbuster video stores to use fiber optic lines to download movies, audio recordings, video
games, and computer software onto writable CDS that run on multimedia PCS.

Virtual Shopping
The Information Superhighway provides consumers with convenient shopping in any store
connected to an on-line service.

Desktop Video Conferencing
Due to the high cost of transportation and the large amount of employee time spent traveling to
meetings, video conferencing is on the rise. A video conferencing terminal can be formed by
attaching a video camera to a desktop computer with interactive multimedia capabilities and a
network connection.

Multimedia Travel Systems
Travel is a natural subject for multimedia because the more you can show a customer about where
they will travel, what their accommodations will be like, and what they will be able to do at, their
destination, the more likely the person will enjoy the trip and want to use your service again.
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Financial Services
Anyone who invests in the stock market knows what a dramatic effect current events have on the
day-to-day value of volatile stocks. This is why the financial service industry is using multimedia
to provide on-screen windows to aid stock market investors.

Real Estate
Another natural avenue for multimedia is the real estate industry. Visiting properties for sale
consumes a tremendous amount of time for brokers and buyers alike. Multimedia computers
enable buyers to visit hundreds of properties virtually, view on-screen photos of homes, inspect
floor plans, see street maps, and study neighborhood demographics to minimize the number of
actual visits required.

Corporate Training
Corporate America spends a fortune on training. The American Society for Training and
Development estimates that as much as $210 billion is spent on employee training each year.
Many corporations have used multimedia to reduce training costs and improve employee
productivity.

Just-In-Time Training
Instruction called just-in-time training is required when something goes wrong and a worker must
find out how to handle it quickly. Companies are now using an interactive multimedia system to
help employees diagnose and fix problems.

Advertising and Electronic Brochures
The more you engage a potential customer with an advertisement; the greater the chance of
making a sale. That is why multimedia provides such an effective way of advertising. The
electronic brochure is a promotional and marketing tool that usually consists of a single diskette
or CD-ROM sent to targeted audiences.

Mass Market Applications
Multimedia is wide open for entrepreneurs who can make a lot of money dreaming up ways to use
it in mass market applications.

NETSCAPE NAVIGATOR
Helpful Tips
It is important to understand a few basic principles about the World Wide Web and the Internet. The
"Web" is a network.of computers which are linked by a central communications network called the
Internet. There are thousands of different locations you can access on the Web, each of these has its own
address. Netscape is a software program which allows you to access these sites and navigate through the
World Wide Web. Below are some tips and definitions which should be helpful for using Netscape.
Once in Netscape you will find menu bars at the top of the screen along with an area to enter address
locations. The address location area will be referred to as the Location Box. Addresses usually look
something like; http://www2.dbc.com/usaweb/quote.html. When entering addresses in the location box you
can usually leave off the prefix and simply start with www.

Bookmarks are a way to permanently mark an address so that when you wish to return to it you don't
have to reenter the entire address.
Organize Bookmarks. When you have many different bookmarks it may be best to organize them into
different directories and subdirectories. Follow these steps:
1.

2.
3.
4.

Click on the Window pulldown menu and choose Bookmarks.
Click on the Item pulldown menu and choose Insert Folder.
Click on and drag the existing bookmarks into the correct folder.
Click on the Item pulldown menu and Sort Bookmarks to sort them alphabetically.

Back will return you to the previous page.

Forward will return you to the original page.
Home will return you to your home page.

Reload will reload the current address you have accessed. This is useful when tracking current and
changing information.

Images turns on or off the graphic images. Turning them off will allow web pages to load much
quicker.

Print will print the current document.

Stop will stop a function in progress. This can be useful if you find a particular site is taking more
time to load then you are willing to wait.
Net Search will start "Search Engines" such as Infoseek Guide, Excite, and Yahoo which you can use
to search for your topic of interest.
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DIRECTORY
Educational Resources
On The Net
Tips for using Netscape:

It is usually not necessary to enter the prefix "http://", simply
start with "www". You also do not need to enter the "I" at the
end.
By clicking on "Options" and then "Auto Load Images" you
can turn off the graphic images and the files will load much
quicker.

ADDRESS & DESCRIPTION
Accounting
http://www.rutgers.edu/accounting/raw.html
Good links and information on Accounting.
http://www.rutgers.edu/accounting/raw/internet/internet.htm
Good accounting resources.

Business
http://www2.mgmt.purdue.edu/html/busedrsrc.html
Business Education Internet Resources. Many very good links.
http://www.law.indiana.edu/law/v-lib/lawindex.html.
Many resources on law and legal issues.

http://www.sbaonline.sba.gov/
Information on starting a business.
http://vvww.entrepreneurmag.com/
Business Start-Ups Magazine On-line.

http://www.uspto.gov/
Information on patents and trademarks, fairly extensive.
http://www.businessexchange.com/
A venture capital service with many good business ideas.

DIRECTORY
Business, cont.
http://www.salesdoctor.com/
Good resource on sales and the selling process.
http://www.directory.net/
Directory of commercial services, products, and information on the Internet

Current Events
http://www.slcywalk.com/
Northwest news and events

http://lody.skywalk.com/
Northwest news and events
http://wwvv.lmtribune.corn/
Lewiston Morning Tribune, Lewiston, Idaho.

http://www.cnn.com/
CNN-Current news and information.
http://vvww.nbc.com/
NBC-Current news and information.

http://www.cbs.corn/
CBS-Current news and information.
http://www.usatoday.corn/
Current news and information.
http://www.wsj.com/
Current news and financial information.
http://www.forbes.com/
Current news and information.
http://www.businessweek.com/
Current news and information.

DIRECTORY
Current Events, cont.
http://www.lciplinger.com/
Current news, information and analysis.

http://www.discovery.com/
The Discovery Channel ONLINE.

Education
http://www.nwrel.org/
Northwest Regional Educational Laboratory. An independent, nonprofit, educational
research and development institution.
http://www.nbea.org/nbea.html
National Business Education Association.

http://www.utexas.edu/world/univ/alpha/
Alphabetic listing of all university home pages. Would be very good for anyone
investigating. universities.
http://vvww.ed.gov/
U.S. Department of Education home page. Many good resources for teachers.

http://www.vpp.com:80/teenhelp/
Teenhelp and good teacher resources.
http://ecedweb.unomaha.edu/naee.htm
National Association of Economic Educators.
http://ericir.syr.edu/
Very good teacher resources.

hitp://www.loc.gov/
Library of Congress.
http://www.bpa.org/bpa.html
Business Professionals of America.

DIRECTORY
Education, cont.
http://www.emcp.corn/
EMC/Paradigm publishes comprehensive educational textbook programs for secondary and
post-secondary schools.

Employment
http://www.webcom.comipiper/state/states.html
Excellent resource for State and Local government information, including the Department of
Employment.
http: / /www. doe. state. id. u s/

Very good resource for jobs in the state of Idaho.

Financial
http://www. quote. com/
Good financial information and stock quotes. Free service limits you to five quotes / day.

http://www2.dbc.com/usaweb/quote.html
Unlimited free stock quotes. Good financial information.
http://pawws.secapl.com/
Good financial information.
http://www.money.corn/exchanges/exchanges.html
List of exchanges and companies on them around the world.

http://www.amex.com/
The American Stock Exchange home page.
http://www.nyse.com/
The New York Stock Exchange home page.
http://www.nasdaq.corn/
NASDAQ home page.

http://www.cbt.com/
The Chicago Board of Trade home page.

13

18

DIRECTORY
Internet
http: / /www.bbn.com/

Good Internet Information.

http://www.sun.com/
Many Internet ideas. This is a commercial site.
http://www.screen.com/understand/explore.html
A very good place to learn about using the Internet.
http://www.search.corn/
More than 250 ways to search the Internet.

Shareware
http://www.zdnet.com/zdi/software/index.html
Shareware-Reviewed and Rated.
http://www.winsite.corn/
Shareware.
http: / /www. jumbo. co m/

Shareware-Around 60,000 programs.

Travel
http: / /www. odci.gov/cia/publications/95fact/index
Excellent resource on countries around the world.

http://usacitylink.com/
Information on cities, states and travel.

http://www.pctravel.com/
Airplane schedules and rates.
http://www.travelweb.com/
Very good resource for finding information on hotel accommodations.

**Downloading**
Downloading is a very important and powerful aspect of working on the Internet.
One of the first things to be aware of is that there are literally thousands of different
software programs on the Net that are either shareware or freeware and are
downloadable at no cost. Downloading is the process of picking a program on the
Web and copying it to a location where you can access it, usually your hard drive or
a floppy disk. Once the program is in a location where it is accessible, you will be
able to install and run it just like any other program.
Freeware implies that the software is free for an indefinite period of time.
Shareware, on the other hand, is not free and is not Public Domain. Shareware is a
computer program distribution and marketing method that permits buyers to
thoroughly evaluate the program subsequent to purchase. If you like a particular
program and wish to continue using it after a designated inspection period, then you
are expected to pay for it by registering with the company indicated in the software
program. Shareware may be copied and passed along to anyone you wish with the
same requirements listed above. If you are not totally happy with the software
program you are inspecting then you can search out new shareware and use it
without spending any money until you find something you wish to keep and buy.
Usually, you will receive additional support materials for a program once you
register and pay for it.

By searching the Internet using the keyword "shareware" you will be able to find
many different programs to download. You can often search libraries of shareware
for programs that meet your individual needs and wants. Once you have determined
which program to download you will click on the download indicator and the
downloading process will begin. The computer will present you with a few options
during this process, one of the most important is choosing a location in which to
place the program you are downloading. This may be your A drive (a:\), or it may
be a particular directory on your hard drive (c: \download). It is up to you to place it
in an appropriate location.
Programs that have been placed on the Internet for downloading are in a compressed
format referred to as a stuffed (for the Mac) or zipped (for the PC)
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Downloading
(Continued)

file. This reduces the size of the file by about half and is thus quicker to download
with fewer individual files. After downloading a program you will not be able to run
it until you decompress it. Although this is not a difficult process, there are a couple
of steps that you will need to learn. In order to unzip a file you need a program
called pkz204g.exe. It can be found on the Internet by typing
ftp://ftp.pkware.com/pub/pkware in the location box in Netscape and pressing
enter. This will take you to a location with several different options and programs
listed. Scroll down until you find nkz2042.exe and click on it. The computer will
then ask you where you would like to save this file. You should save it to your hard
drive. It is also a good idea to put a copy of it on a floppy so that you always have a
backup. After you have received the pkz204g.exe program you will then need to
run it. When you do, it will create several separate files. The one you need to look
for is pkunzip.exe. This is the file that will open any downloaded zip files. It is

important to move a copy of pkunzip.exe into the same directory as the
downloaded zip file before attempting to unzip it. Once you have done this you
should go to a dos prompt, with your location being the same directory as where the
zip file and the pkunzip file are located. Type pkunzip <filename>.zip at the dos
prompt and hit enter. This will unzip the zip file.
After unzipping the file you can return to windows or attempt to run the program
through the dos prompt. If you return to windows you will need to refresh the
screen in order to see the expanded zip file. Once you have found the program you
should look for a .exe file to start it running or an install/setup file to install it on
your computer.
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* *Shareware**
Directions:

Follow the steps below to access Keyboarding and Accounting Shareware

Keyboarding
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.zdnet.com" and hit enter.

3>

Click on "Software Library".

4>

Scroll down until you reach Power Search. In the search location box
type in "typing" and click on the Start Search button. This will give
you a list of many different keyboarding shareware programs with good
summaries and ratings. By clicking on a particular title you will get a
more detailed description and a "DOWNLOAD" button, click on it to
begin downloading.

5>

Here are three programs which we liked.

Typor Typing Tutor v.1.2
PC-Fastype CGA v.4.4
Type Now v.1.0
Refer to the Downloading page for a discussion on downloading. It
may take a few trials and errors before you get things to work right,
hang in there, once you figure it out its well worth it.

Accounting
1>

Follow the above steps and when you get to step four enter
"accounting" instead of typing. You will then get a list of many
different accounting shareware programs.

17.

2;:2

2>

A very good program for double entry accounting is:

Medlin Windows General Ledger v.1.32
The help menu is a very good reference for learning this program.
Once again, refer to the Downloading page for a discussion on
downloading.

Stock Market
1>

Follow the above steps and when you get to step four enter "stock
market" in the search box. You will then get a list of many different
Stock Market shareware programs.

2>

Here's one that is very good for use as a learning tool or to
provide results for a simulated investment competition.

Wall Street Simulator v.1.1
-Simulate a brokerage account
3>

The help menu will be useful in learning how to run this program.

EDUCATION
Trends and Issues
Purpose:

The purpose of this activity is to help teachers, and perhaps their students, familiarize themselves
with current trends and issues in education and provide them with a resource which will easily
allow them to stay current on breaking educational news.

Time Required: As needed.
Directions:

Follow the steps below to access current information about education.

Education
1>

Access the Internet by entering Netscape.

2>

In the location box at the top of the screen type "vvww.acs.ohio-

state.edu/units/education/cete/ericacve/index.html". This will take
you to the home page of the ERIC Clearinghouse.
3>

Scroll down and you will find many different articles and discussions
about educational issues. Pick the ones you are interested in and click
on them. After reviewing your choice you could print the article if you
chose by clicking on "File" at the top of the screen and then clicking

on "Print".
4>

When you want to return to the previous screen and look at another
article click on the `Back" button and then you will be able to pick
another article of interest.
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ECONOMIC INDICATORS
Purpose:

The purpose of this activity is to reinforce your understanding of economic indicators and use the
Internet as a resource tool to find current economic information on the nation.

Time Required: 2-4 Class periods
Directions:

Follow the steps below to answer the given questions.

Questions 1-6
1>

Access the Internet using Netscape.

2>

In the location box type "http://nmg.clever.net/wew/cccc.html".

3>

Scroll down until you find the list of countries and then click on the
"United States" button.

4>

You are now in a location which will link you directly to the answers
for questions 1-6. We will walk through #1.

5>

Click on "Current Account"

6>

At the top of this document is a definition and description of Current
Accounts. Further down the page, you will need to scroll, is a chart
plotting the United States Current Account for the last ten years. Use
this information to answer #1.

7>

After answering #1, click on the "Back" button. You can now scroll
down and click on the next topic which you need to learn about in
order to answer questions 2-6. After you learn about each topic you
can click on "Back" to return to the previous screen.

Questions 7-8
1>

In the location box type "www.fccm.com/histor.html"
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Questions 7-8, cont.
2>

You should now be looking at a graph of interest rates for the past ten
years or so of 30-year T-bills. By looking at this graph you can
determine when a person should have invested in T-bills and if they
would be a good investment today. Remember, hind sight is 20/20.

3>

In the location box type

"http://woodrow.mpls.frb.fed.us/economy/charts/index.htm".
4>

Click on "Other Interest Rates". This will take you to a graph of the
Prime Interest rate along with a couple others. The Prime Interest rate
is the rate at which banks lend to other banks and is usually used to set
the rate at which the average consumer can borrow money, it might be
stated something like this, Prime plus 7%. If the Prime rate was 8%
and you wanted to borrow money you would be charged 15%, thus the
Prime rate is a good indicator of other interest rates.

Questions
Economic Indicators
Directions:

For each topic below you are to write a description/definition and then you are to summarize your
interpretation of the 10 year chart. When interpreting the charts do not worry about getting the
"RIGHT" answer, you are to interpret it and thus part of your answer will be opinion, welcome to
economics, and not necessarily right or wrong.

1>

CURRENT ACCOUNT:

2>

HOUSING STARTS:

3>

CONSUMER CONFIDENCE:

4>

CONSUMER PRICES (INFLATION):

5>

UNEMPLOYMENT RATES:

6>

LEADING INDICATORS:
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Questions
Economic Indicators

Interest Rates
Directions:

Describe each of the terms below while being sure to list the most recent data and
then summarize your interpretation of the charts given.

7>

30-YEAR T-BILLS:

8>

PRIME INTEREST RATE:
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CONSUMERISM
Purpose:

The purpose of this activity is to familiarize you with the process and benefits of
being a conscientious consumer. It will also familiarize you with using the Internet
as a research tool.

Time:

2-3 Class periods.

Directions:

Resources are scarce and limited and therefore it is to a consumers benefit to
maximize any value received in an exchange of goods and resources. You are to
first answer the pre-research questions and then follow the steps on the following
page. You should be able to gain valuable information on automobiles which
could help you as a consumer.

Pre-research Questions
1>

Would you expect to buy an automobile in the same manner you would
buy groceries or clothing? Why or why not.

2>

Define MSRP.

3>

Define Invoice price.

4>

Is it important to know the dealers cost when buying an automobile?
Explain your answer.

5>

In the used car market you should be aware of the retail and wholesale
price of the automobile you are considering buying. Explain the
differences in retail and wholesale pricing.

6>

When shopping for a car should you carry your checkbook/funds with
you so that when you find a good deal you can buy the car right away.
Why or why not?

7>

What are some important factors you should consider when buying an
automobile?

Consumerism, cont
Directions: You are to follow the steps below and answer the questions when
given. After completing these steps go back and answer the Preresearch questions again.
Access the Internet by entering Netscape.

In the location box enter "www.edmunds.com" and hit return.
You are now in Edmund's Automobile Buyer's Guides. Click on New

Cars.
4>

Scroll down and click on "Click here for Car Prices!".

5>

Select a make you may be interested in and click on it. For example
"Ford" or "Toyota". If you are interested in trucks you will need to

click on "To Jump to New Pickups, Vans and Sport Utilities, click
here!"
6>

Pick the particular model you are interested in and click on it.

7>

List the following features on the vehicle you chose.

Make:
Model:
Year:
Class:
Bodystyle:
Drive Type:
Where Built:
8>

Scroll down and click on "PRICES (MSRP, DEALER INVOICE)
AND EQUIPMENT".

9>

List the following about the vehicle you chose.
Invoice Price, MSRP, Destination Charge, and Dealer
Holdback.
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Consumerism, cont.
10>

Click on "Click here for a brief explanation of dealer holdbacks."

11>

Briefly summarize what is meant by Dealer Holdbacks. Will these
hold backs allow dealers to sell cars at or near invoice price? Why or
why not.

12>

Scroll to the bottom of the page and click on "Edmund's Home
Page ".

13>

Click on "Used Cars".

14>

Click on "Click here for Used Car Prices!"

15>

Scroll down and click on the make and year of the car you are
interested in.

16>

List the wholesale and retail price of the vehicle you are looking at.

17>

Click on "Explanation".

18>

Scroll down until you find Price listings. Read this section and briefly
summarize it. Then scroll to the bottom of the page and click on

"Edmund's Home Pane".
19>

Click on "Buyer Advice" for tips on how to prepare and negotiate for
an automobile. Click on "How To Get Your Way at the Auto
Dealer (New Cars)", then click on "How To Prepare for Your Buy
and Trade-in". Read over this section and summarize your findings.

20>

Go back and answer the Pre-research questions again.

COMMUNICATION
Purpose:

The purpose of this activity is to familiarize you with current reading and writing standards and
the rational behind them while using the Internet as a research tool.

Time:

1-2 class periods.

Directions:

You are to follow the steps below and answer the questions as given.

Communication
1>

I2>

Access the Internet by entering Netscape.

In the location box enter "http://www.cde.state.co.us/read.htm" and
hit enter.

I3>
4>

Read the introduction and answer question #1.
Scroll down and review the rest of the article. After reviewing the
article answer #2.

I
Questions
1>

What four basic goals should each student Strive to know and be able
to do.

2>

List the six reading and writing standards and summarize the rational
for each.

RESUME TIPS
Purpose:

The purpose of this activity is to familiarize you with techniques of writing better resumes while
using the Internet as a research tool.

Time Required:

1-2 Class periods.

Directions:

You are to put together a list of five things you should always do and five things you should never
do when writing a resume. You are then to create a resume for yourself following the guidelines
you have put forth. Follow the steps listed below to help you achieve your objective.

Resume Tips
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.rhic.rhalf.com/Career/resume.html",
and hit enter. Read the short introduction on writing resumes.

3>

Scroll down and click on "Always". You will now have a list of things
you should always do when writing a resume. Pick out the most
important five and list them. When you finish you can go to the bottom
of the screen and click on the "Write a Better Resume" button.

4>

Scroll down and click on "Never". You will now have a list of things
you should never do when writing a resume. Pick out the five most
important and list them. When you finish you can begin working on
your resume.

28

33

LAWS
Purpose:

The purpose of this activity is to familiarize you with the process of creating a law while using
the Internet as a research tool.

Time Required:

1-2 Class periods.

Directions:

You are to follow the steps listed below to research the process of creating a law. You are to
summarize your findings and any feelings you may have about the process.

Laws
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.idaho.st.us".

3>

Scroll down and click on "Legislative Department".

4>

Scroll down and click on "Other Legislative Information".

5>

Scroll down and click on "How a Bill Becomes a Law". Once in the
document you will find the appropriate information needed.

6>

You can always return to a previous page be clicking on the "Back"
button.
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LEGISLATIVE ISSUES
Purpose:

The purpose of this activity is to familiarize you with current issues in law and legislation while
using the Internet as a research tool.

Time Required: 2-3 Class periods.
Directions:

You are to follow the steps listed below to research current legislative issues. You are to pick one
area of interest and summarize your findings and discuss your feelings concerning the issue.

Legislative Issues
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.idaho.st.us".

3>

Scroll down and click on "Legislative Department".

4>

Scroll down and click on "Other Legislative Information".

5>

Scroll down and click on the most current "19 Legislative Summary
Session". Skim the introduction and then scroll down until you find
"Legislative Action on Major Issues", you can either click on it and
then scroll through the entire document looking for points of interest or
you can pick an area of interest and click on it. Once in the document
you will find summaries of legislative issues to look through.

6>

You can always return to a previous page be clicking on the "Back"
button.

JOB SEARCH
Purpose:

The purpose of this activity is to:

1> Provide each participant the tools to perform a job search
2> Show the kinds of jobs and careers that are available
3> Use the Internet as a resource tool to accomplish the
above.

Time Required: 2-4 Class periods
Directions:

You are to follow the steps listed below to find specific job and career information. After
becoming familiar with how to find particular job information you will look for jobs that you find
of interest. You will then write a summary, probably no more than one page, listing the specific
jobs (at least five) you found of interest, you are to list job titles, locations. what they pay, job
duration and the amount of education they require. You will then describe, briefly, how you
expect to meet the requirements for the jobs of interest to you.
Please be sure to spell correctly, use proper sentence structure and follow a logical discussion
about your findings.

Job Search
1>

Access the Internet by entering Netscape.

2>

In the location box at the top of the screen type
"www.doe.state.id.us", hit Enter. This is the Idaho Department of
Labors "Idaho Works" home page. Read the introduction.

Move your pointer to "General Information" and click on it. A list of
clickable options will appear. Click on "Job Seeker Services". Read
the short description under "Job Placement", if you wish to read more
than just the short description you may. After reading this, go to the
top of the page and click on "Return to Idaho Works Home Page".
4>

From the home page click on "Job Search".

5>

From the Job Search page click on "Self-Directed Job Search".

6>

You are now in the Occupational Categories page. Here you will find
different job categories. Review the different options as you will be
free to explore each of these after we walk through the process of
finding job information. Click on "Clerical".

Job Search,cont
7>

Here you will find sub-categories of clerical occupations and
geographical areas where the jobs are located. Click in the circle next

to "Shipping and receiving, stock clerks, and related", this will
focus the types of jobs you will search for. Next click on the circle
next to "North Central - Lewiston, Moscow, Grangeville, Orofino",
this will focus your search into these areas. Scroll down until you find
the "Search" button, click on it. The results from this search will be
based on the above qualifications.
8>

Your search results will present you with the following results:
"Job Title
Location
Pay
Duration". Find a job
which may be of interest to you and click on the circle next to it. You
then need to scroll down until you find the "View" button, click on it.
You will now be looking at a detailed description of the occupation
you chose. At the bottom of the page is a description which tells you
how to apply.

9>

If you find something of interest and would like a print out go to the
menu bar at the top of the screen and click on "File", this will present
you with a pull down menu. Click on "Print" and then "OK" and you
will have a print out of the information. Please print only if you intend
on.using the printed information productively, remember, paper is
expensive.

10>

To view other jobs in the same category go to the top of the screen and
click on the "Back" button. This will return you to the different job
listings and you may pick ones of interest and view them.

11>

If you wish to search in different locations. sub-categories, or
occupational categories just click on the "Back" button until you return
to page which has the options you are interested in and change them as
needed.

You now have at your finger tips all the resources to complete this assignment, have
fun!

ENTREPRENEURSHIP
I

Purpose:

The purpose of this exercise is to familiarize you with the process of starting and running a
business.

Time Required:

1-Class period

Directions:

Follow the steps listed below to answer the given questions.
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Entrepreneurship
1>

Access the Internet using Netscape.

Questions 1-5
2>
In the location box type "www.sba.com".
3>

This will take you to SBA's home page. Scroll down and click on
"Starting Your Business".

4>

Find "starting a business" and click on it.

5>

You are now in a document which will help you answer questions 1-5.

Question 6
6>

After answering questions 1-5 click on "Back" twice until you return
to SBA's home page. Once there click on the large "Small Business
Administration" icon at the top of the page.

7>

Scroll down until you find the information to answer question #6.

QUESTIONS
Entrepreneurship
1>

Why are most entrepreneurs not adequately prepared to go into business?

2>

How is going into business similar to a game of chess?

List four common reasons for starting your own business.
a>

b>
.

c>

d>

4>

The first step in starting a business is to determine what type of business you are
interested in. What are some factors (list four) which will determine your choice?

5>

There are three main sections of a business plan, what are they?

6>

Why are small businesses important?
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BUSINESS SEARCH
Purpose:

The purpose of this activity is to familiarize you with various types of business opportunities
while using the Internet as a research tool.

Time Required: 2-3 Class periods
Directions:

You are to follow the steps below and summarize and interpret when indicated.

Important:

This activity will take you into areas of various business opportunities. You will also see a lot of
advertising for business opportunities and Get Rich Quick ideas. It is important to remember and
that many of them may be misleading at best and outright fraud in the worst cases. Ask yourself
this, why would someone be willing to sell their business idea if it was so good, wouldn't they
instead, employ it themselves if it was such a money maker? The point is to investigate and
discover opportunities and watch out for the scams.

Business Search
1>

Access the Internet be entering Netscape.

2>

In the location box type
"www.bizwomen.com/links/opportunity.html", hit enter.

3>

Scroll down and click on "Yahoo-Business Opportunities:".

4>

Scroll down and click on "Easy To Start Businesses". Read the list
of various businesses opportunity and summarize three of them
describing what you like or dislike about them. After you are finished
go to the top of the screen and click on the "Back" button.

5>

Scroll down and click on "Spotlight".

6>

Read the list of business opportunities and summarize one that you
found of interest. In your summary explain why you found it
interesting and whether or not you would consider starting this
particular business.
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STOCK EXCHANGES
COMPARE AND CONTRAST
Purpose:

The purpose of this activity is to familiarize each participant with the major U.S. stock exchanges
and how they compare and contrast while using the World Wide Web as a research tool.

Time Required: Three to five school days.
Directions:

The three major stock exchanges in the United States are:
1)NYSE - New York Stock Exchange
2)AMEX - American Stock Exchange
3)NASDAQ - National Association of Securities Dealers Automated Quotations.
You are to use the Internet to research each exchange and write a summary which compares and
contrast each of the exchanges. Your paper should have enough detail and clarity so that you
could give it to someone unfamiliar with the topic and they would be able to understand how the
exchanges are alike and different.
The steps listed below will guide you to the appropriate Web sites. After accessing the Web sites
listed below you are free to explore and find additional information.

New York Stock Exchange
1>

Access the Internet by entering Netscape.

2>

In the Location box at the top of the screen type
"http://www.nyse.com", hit Enter. This is the home page for the New
York Stock Exchange. As a short cut you can leave off the "http://"
and simply type "www.nyse.com". After reading the contents you
may print it if you find it valuable information. To print you move your
mouse pointer to "File" on the main menu and then click on print. A
submenu will then pop up and you will have various options, if you
want to print the entire document click on "OK". You may print at any
time you feel it appropriate throughout this project.

3>

From the NYSE home page move your mouse pointer to "About the
NYSE" and click on it. This will give you a pretty good description
about the NYSE.
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New York Stock Exchange,cont.
4>

After reading "About the NYSE" click on "Visitors Center" which
will be at the end of the page. This will give you additional valuable
information.

5>

When you finish with the "Visitor Center" click on "Whats New".
You will find this at the end of the page. This option will give you
more information for your project.

6>

If you still need more information at this point you can explore more of
the options from the NYSE Home Page.

American Stock Exchange
1>

In the location box type "www.amex.com", this will take you to the
home page of the American Stock Exchange. You will find useful
information here.

2>

Click on the "Welcome" icon at the top of the page.

3>

From the Welcome Screen click on "Competitive Overview".

4>

From the Competitive Overview screen you will be given a list of what
they consider to be advantages of the AMEX. You can click on each
of these to get a detailed explanation. To return to a previous page
click on the "Back" button on the menu bar. Of particular interest is
"The Chairman's Message", make sure to read through this before
exiting.

5>

If you still need more information at this point you can explore more of
the options from the AMEX Home Page.
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1
NASDAQ
1>

In the location box type "www.nasdaq.com", this will take you to the
home page of the NASDAQ Exchange.

2>

Click on "Glossary". This site should provide you with much
information on the NASDAQ Exchange.

3>

If you still need more information at this point you can explore more of
the options from the NASDAQ Home Page.

SUMMARY,

1

1>

In the location box type "www.cnbc.com" and hit enter.

2>

Click on "EXCHANGES". Here you will find additional information
on each exchange.

At this point you should have enough information to complete your paper. Please
make sure to spell correctly, use proper sentence structure, and follow a logical
discussion about your findings.

1
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CHICAGO BOARD OF TRADE
Purpose:

The purpose of this activity is to learn about the Chicago Board of Trade and Future Contracts
using the Internet as a research tool.

Time Required: 2-class periods
Directions:

You are to answer the questions given by following the steps listed below.

CBOT
1>

Access the Internet by using Netscape.

2>

In the location box type "www.cbt.com ".

3>

Click on "CBOT Home Page"

4>

Scroll down until you see "Visitors Center", click on it.

5>

Scroll down to "Futures Market Jargon: A Glossary of Futures
Terminology", click on it. Use this information to answer questions 14.

6>

After answering the questions click on "Back".

7>

Click on "CBOT: An Overview". Use this document to answer
questions 5-8.

8>

After answering the questions click on "Back".

9>

Scroll down until you find "Frequently Asked Questions", click on
it.

10>

Scroll down to answer questions 9-10.

11>

After answering the questions you may explore around the CBOT for
additional information.
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QUESTIONS
CBOT
1> A Futures Contract is:

2> The Pit is:

3> A Price Limit Order is:

4> A Speculator is:

5> Modern futures trading began

6> What problems led to the creation of the CBOT?

7> Business men use the future market to minimize their

and lower their

8> There are Futures Contracts for many items besides agricultural products.

TRUE

FALSE

9> What is a Bull market?

10> What is a Bear market?

NYSE NEWS
Purpose:

The purpose of this activity is to familiarize you with current events on the New York Stock
Exchange using the Internet as a research tool.

Time Required: 2-3 Class periods
Directions:

Follow the steps below and summarize information when indicated.

NYSE NEWS
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.nyse.com ".

3>

Click on "Publications".

4>

Scroll down and click on "The Exchange Newsletter".

If you do not already have Adobe Acrobat follow steps 5-7. If you do, skip to #9.
Click on the latest version of "Adobe Acrobat".
5>
6>

Click on the "Get Acrobat" button.

7>

Scroll down and click on "free acrobat reader". Follow the
directions to complete downloading.

Click on the "Back" button until you have returned to the NYSE
Publications page. Click on the latest newsletter.
9>

Adjust the zoom by clicking on the magnifying glass at the bottom of
the page. Use the arrows to scroll left or tight and up or down.

10>

Prepare a brief summary of the lead article.

11>

Exit Acrobat Reader by double clicking on the button in the top left
corner.

41

NYSE NEWS, cont
12>

Scroll to the bottom of the screen and click on "What's New".

13>

Click on "New Companies". This will give you a list of companies
which have recently joined the NYSE.

14>

Click on one of the new companies.

15>

Prepare a brief summary about the new company.
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STOCKS
SYMBOLS AND QUOTES
Purpose:

The purpose of this activity is to familiarize you with the process of looking up stock symbols and
prices for particular companies using the Internet as a research tool.

Time Required: One day.
Directions:

You are to follow the steps listed below and record your results.

Stocks
1>

Access the Internet using Netscape.

2>

You need to understand that each stock on the different exchanges is
represented by a unique stock symbol and that in order to look up the
price of the stock you will need this symbol. For example, the stock
symbol for Boeing Company is "BA", these symbols vary from one to
four letters in length.

3>

For demonstration purposes lets assume you read an article on the
Bombay Company in which you discovered that it was traded on the
New York Stock Exchange. You are now interested in finding and
following its stock price. In the location box at the top of the screen
type "www.money.com/exchanges/exchanges.html". This will take
you to a listing of stock exchanges around the world. Scroll down until
you find the "New York Stock Exchange", click on it. You will now
have an alphabetic listing of companies on this exchange.

4>

Scroll down until you find Bombay Company. In parenthesis will be
its stock symbol, write it down if you cannot remember it.

5>

In the location box at the top of the screen type
"www2.dbc.com/usaweb/quote.html".

6>

In the search box type the symbol for the Bombay Company and click
on "Search". You now have a stock quote which is approximately
fifteen minutes old.
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Stocks, cont.
7>

By clicking the "Back" button on the menu bar you can go back to the
previous screen and input another stock symbol. If you need to look
up another symbol you can click the "Back" button again and you will
return to the listing of stocks with their symbols. The other way to
accomplish this is to reenter the site address in the location box and
start the process over.

44

49

BUSINESS TRAVEL
Purpose:

The purpose of this activity is to familiarize each participant with the process of planning and
scheduling a business trip using the Internet as a research tool.

Time Required: 3-5 class periods
Directions:

You have just bought a business which specializes in the manufacture of high-end Mountain
bikes. The problem you face is that your two biggest distributors are considering switching to a
competitor's product. The only real chance you have of saving these relationships is to meet
face-to-face with them in order to determine their needs and how your company is best suited to
continue to satisfy them.
You may assume that your business is located where you are currently located. One of your
customers is located in San Francisco, CA. and the other is in Orlando, FL. You will need to
plan on at least one full day and perhaps two with each customer and one day to site-see. Your
first stop should be to San Francisco. Your goal is to leave Monday and return Friday evening.
A) You are to put together a schedule of your five day trip'which will include:

1> Travel times: Include travel time to the airport, plane schedules, and meetings
2> Hotel locations, phone numbers and which nights you will be there
3> How you will commute once you get there (taxi, car rental, subway, etc.)
4> Estimated cost of each of the above.
B) You are to put together a summary of each city's general information which could include:
1> Population
2> Area attractions
3> Area history
4> Weather
5> Historical landmarks
6> Museums
7> Recreation and Sports
8> etc.

C) You are to write a summary on how you intend on spending your one free day, if you wish you
may divide it into two half days.

D) Estimate the cost of the entire trip.

Airline Tickets
Note: The system will kick you out if there is ten minutes of inactivity and you
will have to start over.
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.pctravel.com", hit enter.
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Airline Tickets, cont.
3>

You must register as a new user before you can access the system. To
do this click on the "New Users" button.

4>

Now click on the "Non-SSL Mode" button. You are now at the
registration page.

5>

Enter your first and last name along with a password. Pay attention to
upper and lower case. You can now click on the "New Users"
button.

6>

There are various options on this next page. The one thing you must
do is enter your address along with your city, state and zip code. By
scrolling down from the top of the page you will find where this
information goes. After entering the information you may continue to
scroll down and input the type of seats and meals you are interested in.
When all the information is filled out to your liking go to the bottom of
the page and click on the "Submit" button.
You are now at the method of payment page. Skip to the bottom of the

page and click on "Skip Entering Payment Information and Start
Reservation Process".
8>

Click on "Check Availability or Make Reservation" button.

9>

Now you must enter where it is you are flying from and where you are
flying to. You need to know the Departure City Code and the
Destination City Code and these codes need to be input into the
designated blocks. In order to find the codes click on the letter of the
city you are interested in and you will get a listing of cities which start
with that letter. Find your city and remember its code. Click on the
"Back" button to return to the previous page and enter the information.

10>

After entering the city information, scroll down until you find departure
and return dates. You must enter both, even if you are not

Airline Tickets, cont.
flying round trip. You can then enter the time you would like to depart
or arrive at your destination. Scroll down until you reach the "Check
Airlines Schedules" button, click on it. You will now have a listing of
airline schedules and one-way fares. To check other cities, times, etc.,
just click on the "back" button until you return to the areas that you
would like to change and then proceed as stated above.

Hotels and Area Information
1>

In the location box type "www.travelweb.com" and hit enter.

2>

Click on "Search the Hotel Database", this will take you to a screen
where you can enter your preferences.

3>

Scroll down the entire document making sure to read as you go and
enter the preferences and locations you are interested in. At the end of
the page you can click on the "Search" button to get a listing of hotels
that meet your stated requirements.

4>

Click on the particular Hotel/Motel you are interested in. You will
now get a listing of detailed information on your selection, towards the
end of the document is where they list the room rates. If there are no
room rates listed do not use this hotel, click on the "Back" button and
search other hotels until you have one with stated rates.
After finding the hotel information read the menus at the top and
bottom of the screen. By clicking on these options you can find our
about Area Info., Restaurants, Recreation, Weather, etc., which should
all help you determine how you will spend your free time.
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SAP
SOFTWARE SUPPLY
Purpose:

The purpose of this exercise is to familiarize you with the Internet and its use as a research tool.

Time Required:

1-Class period.

Directions:

Follow the steps below and answer the given questions.

1>

Access the Internet by entering Netscape.

2>

In the location box at the top of the screen type "www.sap.com" and
hit enter.

3>

Click on "Discover SAP".

Click on "SAP at a Glance".
5>

Answer these questions:

What does SAP stand for?
What does SAP do?
Where are they located?
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OFFICE FURNITURE
Purpose:

The purpose of this activity is to acquaint you with the process of buying office equipment while
using the Internet as a research tool.

Time Required:

1-Class period.

Directions:

You are to follow the steps below and answer the questions given.

1>

Access the Internet by entering Netscape.

2>

In the location box type "www.haworth-furn.com" and hit enter.

3>

Click on the "Furniture With An Attitude" button.

4>

List where their designers are from.

5>

Scroll through the office chairs they have shown. Print out the one that
you would prefer to have at your desk.

6>

At the bottom of the screen click on the "Home" button.

7>

Click on the "Environments That Sing" button.

8>

Click on "Firstar Trust Company".

9>

After looking at their office picture describe the pros and cons of how
it is set up and whether you like it or not.

HUMAN RESOURCES
Purpose:

The purpose of this activity is to investigate and analyze your personality so that you will better
understand yourself and how you can contribute to a team setting.

Time:

1-2 class periods.

Directions:

Follow the steps below and perform the Personality Type Self-Assessment - The Keirsey
Temperament Sorter test and print your results.

Human Resources
1>

Ac.cess the Internet by entering Netscape.

2>

In the location box type "www.gse.rmit.edu.au/rsedc/personality"
and hit enter.

3>

Read the introduction to Personality Analysis. Scroll down and click
on "A Few Words of Caution". Skim this section so that you
understand that this personality test is not absolute and should be used
for self-understanding and not to make final judgments about any
individual. After skimming this section click on the "Back" button so
that you return to the previous page.

4>

Click on "Personality Type Self-Assessment - The Keirsev
Temperament Sorter". Read the directions and then scroll down and
complete the questionnaire. When you have completed all the
questions click on the "Submit" button at the bottom of the page.

5>

You will now be looking at a summary of your personality traits, print
this page. At the bottom of the page is a four letter descriptor of your
personality. Click on it to see a detailed description of common
characteristics of this personality. Print this page.

6>

Summarize your findings and discuss if you feel they were accurate or
not and why. Also, discuss the value in knowing this information and
its usefulness.
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MANAGEMENT
Purpose:

The purpose of this activity is to familiarize you with contemporary management issues while
using the Internet as a research tool.

Time:

1-2 class periods.

Directions:

Follow the steps below to complete this activity.

Management

1

1>

Access the Internet by entering Netscape.

2>

In the location box type "www.ioma.com/ioma/about.html" and hit
enter.

1

3>

You are now in The Institute of Management and Administration's
website. Here you will find many articles on management issues and
Itrends. Scroll down until you find the Human Resources,
Compensation and Benefits section. You are to pick an article and
write a short summary on it. Make sure to include an analysis of your
views on the subject.

I4>

After summarizing one article in the Human Resources, Compensation
and Benefits section, you are to pick another article of your choosing
and summarize and interpret it as well. Remember, you can always
click on the "back" button to return to the previous page.

I
I
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SELLING
Purpose:

The purpose of this activity is to familiarize you with the selling process and in particular with
handling objections. You will accomplish this while using the Internet as a research tool.

Time Required: 2-3 Class periods.
Directions:

You are to follow the steps below and write a summary in which you are to identify:
A> The steps of selling and the purpose of each
B> The six major kinds of objections
C> How objections should be viewed and handled
D> Your personal philosophy towards the selling process.

Selling
1>

Access the Internet by entering Netscape.

2>

In the location box type "www.smartbiz.com/new/sales.htm", hit
enter.

3>

Scroll down until you reach "The Anatomy Of The Sale", click on it.
Here you will find what the authors have determined to be the five
steps of the selling process and the purpose of each. Use this
information to do step A in the directions.

4>

After completing step A, go to the menu bar and click on the "Back"
button.

5>

Scroll down until you find "Handling Sales Objections", click on it.
Here you will find a discussion on Sales Objections, the discussion
focuses on the six major kinds of objections and how to view and deal
with them. Use this article to complete steps B and C.

6>

Complete step D, summarize your philosophy towards the selling
process. At the end of this project we will have a class discussion
focusing on each individuals view of selling.
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INTERNET
Purpose:

The purpose of this activity is to familiarize you with the Internet while using it as a research
tool.

Time Required:

1-2 Class periods.

Directions:

You are to follow the steps listed below and answer the questions as you are directed to them.

Internet
1>

Access the Internet by entering Netscape.

2>

In the location box type "http://ericir.synedu" and hit enter.

3>

Click on the "NEWTON'S APPLE" button. Scroll down and click
on "Season 12".
Scroll down until you find "Internet" and click on it. You are now in
the Internet home page and this is where you will find the questions
which need to be answered . At the top of the page are the first two,
they are:
Why is the Internet sometimes called the information
superhighway?
Why is it growing and changing so rapidly?

You will need to read the text listed below these questions to answer
them. You may need to explore the hyperlinks (underlined words in
blue) to answer them all. After exploring each hyperlink you can click
on the "Back" button, which is part of the menu bar at the top of the
screen, to return to the previous page.
5>

After answering the above questions you will need to scroll down until
you find the following questions which you are to answer. They are:
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Internet cont.
1> Why is access to information valuable? What role does
information play in our society?

2> The Internet lets people around the world discuss issues
without ever leaving their offices, schools, or homes. Will this
have a negative or positive impact on our society and others?
3> Anyone can post almost any information on the Internet.
What are the pros and cons of this?
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TECHNOLOGICAL ISSUES
Purpose:

The purpose of this activity is to acquaint you with current business technology and the changes
that are resulting from it. You will do this while using the Internet as a research tool.

Time Required: 2-3 class periods
Directions:

You have been assigned the task of researching current technological issues and their effects on
the way businesses do business. You should summarize your findings.

Technology Issues
1>

Access the Internet be entering Netscape.

2>

In the location box type "www.today.com" and hit enter.

3>

Scroll down until you find "Innovation: (latest innovation) ", click on
it.

4>

Summarize your findings.
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TELECOMMUNICATIONS
Technology
Purpose:

The purpose of this activity is to familiarize you with modern telecommunications and the
technology involved in it while using the Internet as a research tool.

Time Required:

1-2 Class periods.

Directions:

You are to follow the steps listed below and answer the questions as you are directed to them.

Telecommunications
1>

Access the Internet by entering Netscape.

2>

In the location box type "hftp://ericir.syr.edu" and hit enter.

3>

Click on the "NEWTON'S APPLE" button. Scroll down and click
on "Season 9".

4>

Scroll down until you find "Telecommunications" and click on it.
You are now in the Telecommunications home page and this is where
you will find the questions which need to be answered . At the top of
the page are the first four, they are:
How does a telephone work?
How fast do sound and light travel?
How could fiber optics improve telecommunications?
Are any fiber optics in use today?
You will need to read the text listed below these questions to answer
them. You may need to explore the hyperlinks (underlined words in
blue) to answer them all. After exploring each hyperlink you can click
on the "Back" button, which is part of the menu bar at the top of the
screen, to return to the previous page.

Telecommunications, cont
5>

After answering the above questions you will need to scroll down until
you find the section titles, Things To Talk About. Listed below this are
three discussion questions you are to answer. They are:
1. What are the differences between sunlight and laser light?
2.Would you want a "videophone"?
3. What would Bell think about fiber optics? What new uses for
fiber optic technology can you think of?
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Virtual Economics

Introduction
Background:
The National Council on Economic Education announced that Virtual Economics, An Interactive
Center on Economic Education is now being distributed to elementary and secondary schools
throughout the country. This new economics teaching tool is now available free to schools once
they have completed a one-hour training program. This CD-ROM, published by
Economics America with funds from the National Science Foundation, is designed to give
teachers the resources they need to help students at all grade levels understand the economy and
develop basic decision making skills while learning to use interactive, multi-media technology
designed to promote higher level learning.
The highly interactive tutorial includes a "virtual" gallery with exhibits on key economic concepts.
Newsreel footage, animated graphs, visual puns, and illustrations bring the concepts to life. The
disc includes a 60,000 page resource library of curriculum materials, reference books, plus lesson
plans to teach economic decision making at every grade. Purchased separately, the materials in
this library would cost each school almost $2,000.

"There may be no such thing as a free lunch, but Virtual Economics is next best: our $1.8 million
NSF grant included funds to enable each school building in each school district to get a free
copy," said Dr. Robert F. Duvall, President and CEO of the National Council.
In the "virtual" gallery, the symbol for the- macroeconomic concept unemployment, is literally a
picture of a pink slip; that for inflation is a hot air balloon. Teachers have fun deciphering the
symbols used to illustrate the concepts. Whey they click on them, full explanations of the
concepts, along with teaching ideas and reference cites from the disc's resource library, are
provided. Included in the explanation materials is actual newsreel footage of FDR Gerald Ford,
Jimmy Carter, and many others who make economic policy.

The following "Framework Questions" were designed for two reasons: (1)to give the teachers a
refresher on economic concepts, and (2)to provide the teachers With questions to use in their
classes to accompany the CD-ROM Virtual Economics.
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Getting Started:
Below are the Home screen elements for Virtual Economics. We strongly recommend using the
Exhibit Map button. See the Exhibit Map description for more information.
Navigation window

Legend button
Navigation buttons

Interactive Center for Ecc no is Education

EXIT

Tour button'

(Exit button

Centers Mao button

Resource Library Dutton

Gallery button
Exhibit Mao button

Element Descriptions?
Navigation window - You view the three-dimensional Interactive Center through this
window. It is possible to open exhibits by clicking on objects'in the rooms.
Navigation buttons - These buttons help you move around inside the Interactive Center.
Click once on the right-arrow to pan right, once on the left-arrow to pan left, or once on the
up-arrow to move forward. If you would like direct access to exhibits, try clicking on the
Exhibit Map button.
Legend button - Clicking this button will open the list of exhibits and their corresponding
exhibit icons. Click once in the box in the upper left-hand corner of the window to close it.
Tour button - This button activates a 5-minute tour of the Interactive Center. If this is your
first visit to the Center, the tour is highly recommended.
Centers Map button - EconomicsAmerica, a network of state councils and 260 university
centers is a non-profit partnership of education, business, and labor dedicated to improving
economic literacy. The Centers Map provides information about each of the members of the
network. Click once on the Centers Map button to open a map of the United States. To find
the name of a representative in your state, simply click on the state. When you are finished,
click on the Return button to close the text box or click once on the Gallery button to return
to where you were in the Interactive Center.
Gallery button - Clicking once on this button will return you to where you were in the
Interactive Center.

I Information from this section was adapted from the Virtual Economics handbook included with the CD-ROM.
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Exhibit Map button - This button opens a map, or floorplan, of the Interactive Center using
economic terms. If you feel you are lost, or if you would like immediate access to exhibits,
we recommend you click here.
Resource Library button - This button launches the Adobe/4 Acrobat Reader application
and opens the Resource Library Contents file.
Exit button - Click once on this button to quit, or exit, the application.

When you click on an object in the Interactive Center or select an exhibit from the Exhibit Map, a
screen like this will appear.

Tips button

Element Descriptions:

Text button

Lessons button

Exhibit items - By clicking items on an exhibit screen, you can learn about the exhibit topic.
In this exhibit, clicking on the woman's face will launch a short movie in which a definition of
scarcity is given. Clicking once on the tractor will launch an audio clip which describes capital
resources. To stop an audio or video clip, simply click else where on the screen.
Tips button - This button will pop open a text box which offers a teaching tip. To close the
box, click once on the Return button which appears at the top of the screen.
Text button.- This button opens a text box in which an excerpt from A Framework for
Teaching Economics appears. The text provides a succinct explanation of the exhibit topic.
Click Return to close the text box.
Lessons button - Clicking this opens a text box which contains a series of content statements
as well as lists of recommended lessons for your students. The lessons are easily accessible
through the Resource Library. You may wish to keep a notepad handy to jot down a few
titles to search for during a later library visit.
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Virtual Economics

Framework Questions
Scarcity and Choice
What is scarcity and how does it relate to choice?
What are economic wants?
Compare goods with services.
Identify and describe three productive resources.

Opportunity Cost and Trade-Offs
Differentiate between opportunity cost and trade-offs.
What is the opportunity cost of a college student attending college?
How does marginalism help consumers decide what to purchase?

Productivity
Discuss what productivity is and how it is measured.
Define specialization and show examples of how it can be practiced by individuals,
business, firms, cities, regions or countries. How does it promote trade?
How is division of labor related to specialization?
Discuss what savings are and how savings can be used for investment in capital goods.
How does investment in human capital increase productivity?
What does the introduction of new technology do to productivity?
How do government actions and policies play a role in productivity?

Economic Systems
Identify and describe the three basic approaches to economic decisions about resource
allocation.
What activities do people of all societies, regardless of the type of economic system, engage
in?

Economic Institutions and Incentives
Identify and describe the different kinds of economic institutions.
Explain how incentives can motivate and influence human behavior.
What are some incentives students encounter at school?
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Exchange, Money, and Interdependence
Name and describe the different forms of exchange we encounter in our society.
How does money work as a means of exchange since it does not have any intrinsic value.
Explain the concept of interdependence and its affect on the economy.

General Economics
Differentiate between microeconomics and macroeconomics.
What concepts does microeconomics include?
What concepts does macroeconomics include?

Markets and Prices
Discuss the concept of markets.
What are prices?
Differentiate between relative and absolute prices.
Illustrate what an exchange ratio is.
Identify and explain the three principle functions in a market system.
Draw a diagram of the circular flow of resources, goods, services, and money payments.

Supply and Demand
Contrast the.concepts of supply and demand. Use examples to support your answer.
What is the difference between quantity supplied or demanded and supply and demand?
When do the forces of supply and demand work best?

Competition and Market Structure
What does the term market structure refer to?
Draw a diagram of the market structures running from highly competitive markets to those
that contain only a single seller.
Identify and define all the different market structures.
Describe what a cartel is.

Income Distribution
Define the following terms: wages, salaries, rent, interest, profit.
Compare the functional distribution of income with personal distribution of income.
Describe the concept of transfer payments.
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Market Failures
Identify and describe the different forms of market failure.
What are externalities?
Compare and contrast public goods with private goods.
Describe when government failures occur.

The Role of Government
Explain the concepts of taxes.
Differentiate between proportional, progressive, and regressive taxes.
Draw a diagram of the government in the circular flow of resources, goods, services, and money
payments.

Gross Domestic Product
Contrast a final product from a immediate product.
Explain the concept of value added.
Differentiate between current prices and constant prices.
What is economic growth.

Aggregate Supply and Aggregate Demand
Define aggregate supply and use examples to support your answer.
Define aggregate demand and use examples to support your answer.
What is the velocity of circulation?

Unemployment
What is the unemployment rate?
Who makes up the labor force?
How is the employment rate different from the unemployment rate?
Distinguish between frictional, structural, and cyclical unemployment.

Inflation and Deflation
Compare inflation and deflation.
Illustrate the differences of demand-pull and cost-push inflation.
How can price expectations influence the rate of inflation?
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Monetary Policy
How does monetary policy affect the amount of money available in the economy and its cost?
How does the Fed tighten the money supply?
How does the Fed increase the money supply?
Why is monetary policy the subject of considerable controversy?

Fiscal Policy
What does fiscal policy consist of?
How can fiscal policy affect total aggregate demand?
Why is it difficult for fiscal policy to promote overall economic stability and growth in the
economy?

International Economic Concepts
What is international economics?
What concepts does international economics include?

Absolute and Comparative Advantage and Barriers to Trade
Compare the concepts of absolute and comparative advantage. Give specific examples to
back your answer.
List some barriers to trade.
How may monopolies affect international trade?

Exchange Rates and the Balance of Payments
What is an exchange rate?
How is the balance of payments of a country determined?
Explain what a current account includes.
What does a capital account consist of?

International Aspects of Growth and Stability
Through which channels do international investment take place?
How can the flow of labor across international borders promote economic growth?
How can a war change economic opportunities?
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Broad Social Goals
Explain the concept of economic freedom using examples.
Illustrate the two meanings efficiently can have using examples of each.
Describe what economic equity is.
What does the goal of economic security concern? What are some of the risks of which
people have no control over.
Define full employment.
Identify what price stability means supporting your example(s) fully.
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Extended Virtual Economics
Activities
Directions: Use the Virtual Economics Interactive Center to find the answers to the following
activities. It is strongly suggested that you use the map to find the answers since this is the most
efficient way to go from topic to topic. You may also find it helpful to go into the Virtual
Economics framework text to help find the answers. Most of these activities were taken from
lessons provided to you in the resource part of the software.

Navigation:
Map:
Click once on the "map" button while in the Interactive Center. This will bring you to a map
of all the economic concepts.
Click once on the topic of your choice.
Clicking on the word "text" will bring you into the framework for the software.
Clicking on the pictures will give you various information about the topic.
Clicking on the work "lessons" will give you teaching ideas and resources you can use for
your lesson.
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BASKETBALL CONCESSIONS
PRICE LIST
Item

1993

1994

Program

$ 2.00

$ 3.00

Basketball
Cap

8.00

11.00

Popcorn

1.00

2.50

Basketball
Cards

2.00

1.50

For the first game of the 1993 basketball season, you saved $ 13.00 from your
allowance to buy food and souvenirs. You spent it on a program, basketball Cap,
popcorn, and basketball cards.

1. How much did you spend on these four items in 1993?
For the first game of the 1994 basketball season, you have saved $ 15.00 from
allowance for food and souvenirs. You plan to buy the same four items. We you arrive
at the coliseum, you realize you do not have enough money.

2. What will a program, a basketball cap, popcorn, and a pack of basketball cards cost

this year (1994)?
Why did

3. What happened between 1993 and 1994?
happen?
4. Why can't you buy everything you want?

5. What will you choose?
What will these items cost?
6. The Opportunity Cost is what you gave up to get the items you bought
What is your opportunity cost?

7. What do you predict will happen to prices next year? Why?
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Handout 1-4-1

Cassandra Goes to College
What is the problem?
Cassandra is a senior in high school. She has decided to go to college after she graduates from Kennedy
High School. She is currently thinking about majoring in English literature, but that could change. She is the
oldest of three children and is the first in the family to go to college. It is a big decision for her and her
family. Money, at least for the first year or two, is not a big problem. She has some money saved from the
Social Security payments she has received for the last six years since the death of her father. The main
problem is that she doesn't know which college is best for her.

What are the alternatives?
Cassandra and her mother agree on three. They visited each campus.
Metropolitan University
MU is a state university near Cassandra's home. It has a solid reputation for good teaching

especially

in the English Department. Some of Cassandra's friends plan to go to MU, but her closest two friends
will go elsewhere. The school's tuition is modest. Cassandra could live at home, so the out-of-pocket
cost of going to school would be low.
Big Main State University
BMSU is a large state university. It ranks overall as one of the top colleges in the country and is best

known for its programs in law and medicine. As a state-supported school, its tuition fees are modest;
however, the cost of renting a dorm room and meals would be an added expense as well as the cost of
travel to and from home. Cassandra's two best friends, Missy and Mariah, plan to go to BMSU.
Essex University
EU is a small liberal arts school with a good reputation. Its English literature department is known to be
first-rate. Essex is located in a nearby state; the cost of tuition is very high. None of Cassandra's friends
plan to attend EU.

What are Cassandra's criteria?
Cassandra has given it a lot of thought.

She has come up with four criteria that she thinks are most

important to her. First, she knows that because her funds are limited, tuition costs are an important factor.

Second, while she would not mind living at home, Cassandra thinks she would prefer to be more
independent. Third, Cassandra likes her friends and would like to attend the same school that they choose.
Finally, Cassandra would like to be sure that the professors really know their subjects and care about their
students.
Use the Decision Grid and Cassandra's criteria to help decide what you think Cassandra should do.
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Handout 1-4-2
Decision Making Grid
1. What is the problem?
2. What are the alternatives?
3. What are the criteria?
4. Rank the criteria.
5.

Evaluate the alternatives.

6. Make a decision.
Criteria

Rank of Criteria

Alternative 1

Alternative 2

Alternative 3

Alternative 4

Decision:
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Name

Activity

CONGRATULATIONS! You Just Won the NBA Championships
Last year your basketball team finished last in their division. This year they won the
NBA Championship. Because of this phenomenal feat, all the players want to
renegotiate their contracts.
As the owner, you must determine the players' salaries for next year. Use your
calculator or long-hand and the formulas below to calculate the points per game
(PPG). Put your answers in the appropriate columns on the chart below.

POINTS PER GAME (PPG) = a decimal expression of the number of points divided by
the number of games played by the player. PPG is rounded to the nearest tenth
of a point.
for example: Ted the Terrible made 2400 points in 80 games played. So, 2400
points/80 games = 30.0 points per game.
Now determine each player's salary for the next year using the following criteria:
1. A player who shoots 25 or more points per game is worth $2.5 million.
2. A player who shoots between 15 and 24 points per game is worth $1.0
million.
3. A player who shoots between 5 and 14 points per game is worth $500,000.
Put your decisions in the correct column below:
Number of
Points made
Player Name
games played.
during year.
80
2400
Ted the
Terrible
60
Daniel the
1500
Dunker
60
1200
Lynn's
Famous
Layups
35
1400
Brian, the
Bruiser
75
750
Joe the Slow

Points per
game.
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Salary Next
Year

Handout 1-8-4

Classifying Types of Economic Activity
Directions: Below is a list of examples of economic activity. Discuss the examples with the other people in
your group. Then decide, for each example, whether it represents a market, tradition, or command
economic system. Write the number of the example in the correct column. Have reasons ready to
support your decisions. Before you return to the whole group, be sure to add two or three examples of
your own for each category.
Ralph becomes a police officer because his father was one -- it runs in the family.

1.

2.

Alice thinks that her community needs another discount computer store, so she decides to start her
own business.

3.

Norton is retired now, so he collects Social Security.

4.

Trixie refused to buy a pair of jeans because they cost too much.

5.

Every September George buys a new Chevrolet because every year he buys a new Chevrolet.

6. Gracie and her family live in housing which the federal government provides at a reduced rent.

7. To increase his income, Huang Pei lin raises chickens, ducks and geese which he and his family sell at
a local free market in northern China.

8. The Soviet State Planning Commission (Gosplan) decides how many tons of coal should be produced.
Stock market prices decline in Tokyo because of large offerings of steel stocks for sale.

9.
10.

In Mexico City, business slacks off for lunch at 2:30 p.m. and gets started again around 5:00 p.m.

11.

Soviet doctors may treat patients at home for a fee.

Soviet doctors are employees of the state; any fee they charge for home treatment is regulated by
the state.

12.

Types of Economic Activity

Market
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Traditional

Command
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Resource 7-1
THE COMMUNITYVILLE TOUR
NARRATOR: Welcome aboard the Communityville school bus. Today you will be
taking a tour of Communityville. We hope you will find the tour informative and exciting.
Your tour guides will be children who live in Communityville. They will tell you all
about Communityville and how they and their families depend on people and places
in Communityville for goods and services they want. Your tour begins at the school,
where your tour guides are waiting to meet you.

TOUR GUIDE NO. 1: Hello, my name is Shane. Welcome to Communityville. This is
my friend Jennifer. We will be your tour guides as we travel through Communityville.

TOUR GUIDE NO. 2: Hello, my name is Jennifer. We are happy to tell you all about
our community. We will begin by telling you about our school. Shane and I go to
school here. My younger sister, Jessica, does too. We all like it very much. We depend
on the school for our education. The teachers and principal help us learn many things.
My class did a special project. We did research about Communityville, wrote reports,
and then published a book about our community. People in the community bought the
books to learn more about Communityville. Our class earned a profit and with the
money we bought books for our school library. It was an exciting project.
Shane will now continue with the tour.

TOUR GUIDE NO. 1: The school also has a wonderful playing field. Jennifer plays
on a soccer team here, and I play on a baseball team. My younger brothers, Drew and
Chase, like to come and use the playground equipment. The swings and slide are fun.
Sometimes, we see Jennifer's younger sisters, Jessica and Jacqueline, playing here,
too.

We will now turn north on School Street. On your right you will see our police station,
where police officers are on duty day and night helping people and protecting property
in Communityville. Next you will see the post office. Drew, Chase, and I like to mail
letters. Sometimes, we get letters from our friends who live in other communities. The
letter carrier takes our mail from the post office and delivers the letters to our house.
We appreciate this service because, otherwise, we would have to get the mail
ourselves. Jennifer, Jessica, and Jacqueline get packages from their grandparents,
who live far away.
Looking ahead you see the road to the airport. My brothers and I like to go to the
airport when my mother goes away on a business trip. Jennifer's father also flies far
away on business. When we go to the airport, we see people who fly here to
Communityville to do business.. Jennifer will now tell you about the museum.

TOUR GUIDE NO. 2: A famous place in Communityville is the sawmill. Part of the
sawmill is now a museum. People like to learn how lumber was produced long ago.
We brought my grandparents to the museum when they came to visit.
VE6
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Continuing on our tour, we turn east on Central Avenue. Notice the library on the left.
The library has many books for people of all ages. Jessica, Drew, Chase, and
Jacqueline go to the library for a story time and a puppet show every week.
On our left, we see a shoe factory. Many of my friends' parents work here. We buy
most of our shoes from the factory store. The factory sells its shoes to businesses in
other communities, too.

On our right, we see the fire station. The fire fighters are always ready to serve the
community in case of fire.
Beyond the shoe factory is a place we all like to go to. It's the shopping mall. There
are many stores offering just about anything you might want. Next, we see the Car
Sales and Service Shop. My father just bought a car from this shop, and Shane's
mother just had her car repaired there. On our right, we see the Communityville
Hospital. My sisters and I were born there; so were Shane and his brothers. Also, here
is the doctor's office, where we receive health care. There is a dentist here, too, and
twice a year all six of us have our teeth cleaned and checked.
We are now turning south on Oak Street. On your left, you will see the
Communityville Hotel. Some people stay here when they visit us from far away. It's a
nice place to stay for those business people who fly into our airport. On our right is an
office building in which there are many small businesses. Many people depend on
these businesses for their jobs. Our bus will stop later at the service station on Main
Street for gasoline.

TOUR GUIDE NO. 1: We will continue down Main Street. On our left, we see the
bus station and the railroad station. My brothers and I went on a train trip to see our
grandparents. Many people travel to nearby communities for fun and also to buy
goods and services, just as the people in nearby communities come here to visit us
and to buy goods and services.
On our right we see the bank. Sometimes, my brothers and I go to the bank and put
money into our savings accounts. People save money, borrow money, and cash
checks at the bank.
Across from the bank is the Communityville Grocery Store. I like to help choose the
food for my family. My parents won't let me buy all the candy and treats I want.
Jennifer's family shops at this grocery store also.

Continuing on our tour, we see the city hall. The city hall is a government building
where the people come to vote, pay taxes, and get answers to questions about laws
and rules. People who work at city hall help keep Communityville a nice place to live.
If you look south on School Street, you will see a farm. That is where Jennifer,
Jessica, and Jacqueline live. I live in the neighborhood across from the farm along
with my brothers, Drew and Chase.

VE7

Here we are back at Communityville School. Jennifer and I thank you for your
attention and hope you enjoyed the tour.

NARRATOR: We hope you had an enjoyable tour and learned about all the people
we depend on in Communityville. Thank you and come again.
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Resource 7-2
FAMILY COMMUNITY TOUR ACTIVITY
INTRODUCTION:
The community tour activity is designed to encourage family participation in an
economic education unit your child is studying at school entitled Exploring the
Community Marketplace: The Community Publishing Company. In this activity, your
child's assignment is to describe the goods and services that are available to your
community by filling out the Family Community Tour Information Form that
accompanies this information sheet.

PURPOSES:
This activity will help reinforce the following economic ideas presented at school.
1. A community includes a variety of places that produce goods and services for its
residents and visitors.

2. People decide where to buy goods and services. They may base these choices on
the following criteria: location, price, dependability, safety, personal service,
appearance, and advertising.
3. People buy goods and services at one place rather than some other that sells the
same products because of price, location, personal preference, etc., at the place
selected.
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I
FAMILY COMMUNITY TOUR INFORMATION FORM
IMy name is
I

live in (name of community, town, village)

The name of the street/road I live on is
I think people who come to visit my community would like to know about these places.
(For each place write the name of the business and the street on which it is located.)

gasoline for vehicles, repairs

1. The
cars, and washes cars. The street it is located on is

I

sells many kinds of canned goods, meat,
2. The
bread, cookies, fruit, and vegetables. The street it is located on is

I

olonans, accepts savings
3. The
m
accounts, and cashes checks. The street it is located
is

sells stamps and delivers letters,
I4. The
packages, and cards. The street it is located on is

1

offers health care. The street it

5. The
is located on
Iis

provides a ball field, swings, slide,
6. The
Iand a jungle gym. The street it is located on is
7. The
and sweaters. The street it is located on is

sells clothes, shoes, coats, stockings,

sells a variety of food, and offers friendly
I8. The
service and a pleasant atmosphere. The street it is located on is
I9. I think the most important place in my community is
because

I

I
VE10
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Handout 2-7-2
Reasons for Changes in Demand

U
O.

Beef consumption in May (CO

Read the following eight newspaper headlines. In each case decide if the event will cause a change in the
demand for beef. If so, determine if it is an increase or a decrease, and write the correct answer. Begin at
curve C. If you think headline 1 means there will be a decrease in demand, write "decrease" in the first

blank and "B" in the second blank; move to curve B to do headline 2. If you think demand will increase,
write "increase" and "D" in the blanks for headline 1; move to curve D to do headline 2.
Move only one curve at a time. Do not skip from say A to C even if you think the headline means there will

be a large change in demand. Do not go beyond the five curves. If you are at A and the next headline
implies a decrease in demand, you goofed somewhere. There is one headline which implies that the
demand for beef does not change.
1 PRICE OF BEEF TO RISE IN JUNE
Curve
Demand

2 MILLIONS OF ALIENS SWELL U.S. POPULATION
Curve
Demand
3 PORK PRICES DROP
Curve
Demand
4 SURGEON GENERAL WARNS THAT EATING BEEF CAN BE HAZARDOUS TO HEALTH
Curve
Demand
5 MIGRATORY BIRDS HEAD NORTH; SUMMER AWAITS
Curve
Demand

6 REAL INCOME FOR AMERICANS DROPS 3RD MONTH IN ROW
Curve
Demand
7 CHARCOAL SHORTAGE THREATENS MEMORIAL DAY COOKOUTS
Curve
Demand

8 NATIONWIDE FAD: THE DISCO-BURGER
Curve
Demand
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Optional bonus: Categorize each change in demand in the exercise above according to the reason that
demand changed. Write the number of the headline(s) next to the reason for the change in demand. One
category will have two headline numbers.
A change in consumer expectations
A change in consumer tastes
A change in the number of consumers in
the market
A change in income
A change in the price of a substitute good
A change in the price of a complementary
good

VE12
Copywright© 1989 Joint Council on Economic Education
Reproduction is prohibited without written permission from The Joint Council on Economic Education

Handout 2-7-3
Reasons for Changes in Supply

0.

Supply of foreign and domestically produced
Cars in the U.S. (0)

Read the following seven newspaper headlines. In each case, decide if the event will cause any change
in the supply of cars. If so, determine if it is an increase or a decrease, and write the correct answer. Begin
at curve C. If you think headline 1 means there will be a decrease in supply, write "decrease" in the first
blank and "B" in the second blank; move to curve B to do headline 2. If you think supply will increase, write
"increase" and "D" in the blanks for headline 2; move to curve "D" to do headline 3.
Move only one curve at a time. Do not skip from say A to C even if you think the headline means there will
be a large change in supply. Do not go beyond the five curves. If you are at A and the next headline
implies a decrease in supply, you goofed somewhere. There is one headline which implies that the supply
of cars does not change.
1 AUTO WORKERS UNION AGREES TO WAGE AND FRINGE CUTS
Curve
Supply

2 NEW ROBOT TECHNOLOGY INCREASES EFFICIENCY
Curve
Supply
3 NATIONWIDE AUTO STRIKE BEGAN AT MIDNIGHT
Curve
Supply
4 NEW AUTO IMPORT QUOTAS REDUCE FLOW OF FOREIGN CARS
Curve
Supply
5

COST OF STEEL RISES

Supply

Curve

AUTO PRODUCER GOES BANKRUPT, CLOSES OPERATION
Curve
Supply
6

BUYERS REJECT NEW MODELS
Supply
Curve
7
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Optional bonus: Categorize each change in supply according to the reason that affected supply. Write the
number of the headline next to the reason for the change in. supply. In some cases, more than one
headline could be matched to a reason.
A change in the cost of production
A change in technology
Natural disaster/other event that causes
decrease in production
Government policies
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Handout 2-8-2
Big Football University

Dollar
Price
180

150 --Market
price \

120

60

T University's
price

30 -6-

25 50

90

125

Quantity: season tickets
(6 games) per year
(in 1,0008 of tickets)

Instructions: For these questions, assume the university has set the price of a season ticket at $90. It will
take action against people who it discovers reselling tickets at a higher price, that is, it will try to prevent
"black market" or "scalper" sales (sales above $90).
1 Answer these questions on the basis of the information in the graph:
a Why is the supply curve a vertical line?
b How many tickets are available at the university's price?

c How many tickets do football fans wish to buy at the university's price?

d What is the problem with respect to quantity supplied and quantity demanded?
e Does the graph illustrate a price floor or a price ceiling?

2 What are some means of eliminating the shortage of tickets in order to prevent "black marketing" or
"scalping"?
3 For each solution you put forward, answer the following questions:

a Will the solution eliminate the shortage?
b Is the solution fair?

c Who benefits from the solution? Who loses?
d What is the best solution?
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Handout 3-7-1
Different Types of Market Structure
Market
Structure

No.

Of

Type of
Product

Contitions
of Entry

Type of Pricesetting behavior

Existence
of Nonprice
Comptitiion

Firms
Pure (perfect)
comptitiion

Many

Homogeneous

Free or
very easy

Determined by
market

None

Monopolisitic
comptition

Many

Differentiated

Relatively
easy

Determined by
market plus small
amount of
discretion

Some,
especially by
advertising

Pure
oligopoly

Few

Homogeneous

Substantial
barriers

Differentiated
oligopoly

Few

Differentiated

Substantial
barriers

Monopoly

One

Only product
of its kind
avilable

Examples

1

Entry can
be blocked

Determined by
market plus
considerable
discretion.
Possible price
leadership

Some, such
as on-time
delivery

Determined by
market plus
considerable
discretion Possible
price leadership

Extensive

Establishes price at
most profitable
level possible

Advertising
of firm's
"image"

From Master Curriculum Guide in Economics: Teaching Strategies for High School Economic Courses. 1985 Joint Council
on Economic Education, 2 Park Avenue, New York, NY 10016.

VE16
Copywright® 1989 Joint Council on Economic Education
Reproduction is prohibited without written permission from The Joint Council on Economic Education

87

Handout 4-3-1

One Nation or Thirteen?
Directions: Read the information below and respond to the questions which follow.

The American people had just fought the American Revolution, a remarkable accomplishment in the eyes
of the world. Now, the economic problems facing the new nation had to be solved. To many, the situation
seemed bleak.

Debt: After the Revolutionary War, Congress faced huge debts. We owed money to the French, who
helped support the war. Money was also owed to American citizens who had previously bought bonds from
the government to help support the war effort. The debt problem was so severe that there was serious talk
about simply not paying the debts. Some people argued that these bonds had changed hands several
times. Congress would not be paying debts to the people who originally helped support the war effort but to
speculators who purchased the bonds from them. Other people, however, feared that such drastic action
would weaken the confidence of other nations in the new government and severely hurt its economic future.
Power to Tax: The federal government could levy a direct tax only if the money was returned to the states
on the basis of population. In other words, the federal government really had no way to collect revenue to
pay for its own expenses. Only the states had this power. There was no practical way for Congress to meet
its financial obligations.

Currencies: Congress issued currency and coins, but so did several of the states. In fact, foreign
currencies from Spain, England, and France were seen by many as more valuable than currency produced
by the government under the Articles of Confederation. The situation was very confusing to consumers and
very uncertain for business people.
Tariff wars: There were signs that tariff wars would erupt among the states. New York imposed a fee on
vessels traveling to and from Connecticut and New Jersey. Not to be outdone, New Jersey imposed its own
tax on a New York-owned lighthouse on New Jersey soil. New Jersey, lying between New York City and
Philadelphia, found its exports heavily taxed. Leaders in other states watched attentively and considered
placing their own taxes on products from neighboring states. After fighting a military war with the British,
some leaders now feared a tariff war among the 13 states.

Military weakness: Britain continued to occupy territories in the Great Lakes in open violation of the

agreement with the United States in the treaty of Paris that ended the Revolutionary War. This showed the
ability of Americans to begin economic development of the Northwest Territory. The Spanish refused to
allow Americans to navigate parts of the Mississippi River. Meanwhile, the Barbary pirates were attacking
American shipping in the Mediterranean Sea.

Questions
1. What might have happened if the United States, under the Articles of Confederation, had not paid its
debts?
2. What might have happened if no way had been found for the central government to collect taxes?
3. What might have happened if no one currency had been accepted?
4. What might have happened if tariff wars had broken out among the states?
5. What might have happened if the United States had remained a weak military power?
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Handout 2-8-3
The Minimum Wage and Unemployment
Imagine that you are a member of the U.S. House of Representatives. You must decide whether to vote
yes or no on a bill that would raise the minimum wage. In committee hearings on the bill, you heard
testimony from people who favor the increase and from people who are against it. For example, you heard
one spokeswoman say:

"We're experiencing high inflation. The minimum wage must be raised accordingly. Otherwise, the
working poor will receive wages that are miserably below what is needed to provide food; housing, and
other necessities. Every worker has a right to earn a decent, living wage. The present minimum is too
low and is therefore unjust and unfair."
And you heard an opponent of the minimum wage state:
It creates unemployment, especially among
disadvantaged minorities and teenagers. It creates incentives for businesses to substitute machines for
people. People without jobs are worse off than people with low-paying jobs. This is particularly true for

The minimum wage should be allowed to expire.

teenagers. Teenage unemployment is much higher than adult unemployment. One of the reasons is
that the minimum wage reduces the number of jobs for teenagers with few skills, for at the minimum
wage business would rather hire older people who are more skilled or who have more work experience.
Such hiring decisions tend to discriminate against young blacks who, on the average, have less education
and fewer skills than their white counterparts. Don't raise the minimum wage; eliminate it."
Now you must decide how to vote.

QUESTIONS:
1. What is the issue?
2. Draw a supply and demand graph that illustrates the issue. Does the issue involve a price floor, a price
ceiling, or neither?
3. What broad social goals should you consider as you decide how to vote on this issue?
4. What are some alternative means of achieving these goals?

5. What are some advantages and disadvantages of each alternative? Be sure to consider who gains
and who loses by each alternative.
6. Would you vote to raise the minimum wage? Why or why not?
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Handout 2-9-1
Handy Dandy Guide (HDG)
1) People economize.

What choice is being made?
Who is making the choice?
2) All choices involve costs.

What are the alternatives?
What is being refused?
3) People respond to incentives in predictable ways.

What are the potential benefits?
What are the potential costs?
Have they changed?
4) Economic systems influence individual choices and incentives.
Have choices made by others influenced the individuals in the situation?

What are the rules of the system?
Have the rules changed?
5) Voluntary trade creates wealth.

Why is exchange taking place or not taking place?
How do these choices influence trade and exchange?
6) The consequences of choice lie in the future.

What costs and benefits do you foresee?
How uncertain and risky is the choice being made?
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Handout 7-8-1

Exchange Rates: Importer
As a buyer of Imported goods for a department store chain, you would like to get your purchases from
abroad as cheaply as possible. However, you must pay the sellers in the currency of their own country. The

values of currencies can change rapidly as import and export demands change, and as governments
intervene to try to control the values of their currencies.
Consider three alternative sets of hypothetical exchange rates:

Case 1: $1 = 200 Japanese yen (Y) = .67 British pounds£ = 2 West German Marks (DM)
Case 2: $1 = 150 Y = .50£ = 1.5 DM
Case 3: $1 = 300 Y = 1.00£ = 3.0 DM

By filling in the table below, you will discover the effect of changes in exchange rates on the price you must
pay for your imports. To get the correct answer, divide the foreign price by the country's exchange rate. The
answer will equal the price in dollars.

Price in foreign
currency

Product
Video cassette
recorder

Wool coat
Cuckoo clock

Case 1

Price In dollars:
Case 2

Case 3

60,000Y
40£
200DM

Compare your table with those of others in your group to make sure you have computed the prices
correctly. Then, as a group, determine the answers to the following questions:
1.

In which case were your costs as an importer lowest? The highest?

2.

In which case would you probably import the most foreign goods?

3. A "strong dollar' is one that can be exchanged for a relatively large amount of foreign currency. As an
importer, would you prefer a strong dollar or a weak dollar?
4.

In which case would you store most likely offer its products at the lowest prices?
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Handout 7-8-2

Exchange Rates: Exporter
You run a business which acts as an export agent for domestic producers who sell their products overseas.
Of course, your clients want to be paid in dollars. That means the ultimate cost to the buyers depends on
the amount of their currency they need to obtain the number of dollars the require. The values of currencies
can change rapidly as import and export demands change, and as governments Intervene to control the
values of their currency.
Consider three alternative sets of hypothetical exchange rates:
Case 1: $1 = 200 Japanese yen (Y) = .67 British pounds£ = 2 West German Marks (DM)
Case 2: $1 = 150 Y = .50£ = 1.5 DM

Case 3: $1 = 300 Y = 1.00£ = 3.0 DM

By filling in the table below, you will discover the effect of changes in exchange rates on the prices
foreigners must pay for your clients' products. To get the correct answer, multiply the price In dollars times
the country's exchange rate. The answer will equal the price in the foreign currency. Remember, there will
be three answers in each case.

Price In foreign currency:
Product

Price In dollars

Bushel of wheat

$ 3.00

Ton of coal

$60.00

Micro-chip Processor

$12.00

Case 2

Case 1

Case 3

Compare your table with those of others in your group to make sure you have computed the prices ,
correctly. Then, as a group, determine the answers to the following questions:
1.

In which case were foreigners' costs for U.S. products the lowest? The highest?

2.

In which case would your clients probably be able to export the most products?

3. A "strong dollar is one that can be exchanged for a relatively large amount of foreign currency.
exporters, would your clients prefer a strong or a weak dollar?
4.

In which case would your clients probably employ the most people?

BUT COPY AVAIIIIABIE
VE21

92

As

Virtual Economics Activity for Fiscal Policy
Navigation
Click once on Resource Button
Click once on Curriculum Materials 9-12
Click once on Document Titles
Locate and click once on A Teenager's Guide to Money. Banking & Finance
"Understanding the Federal Debt"
Answer the following questions
1.

What is the national debt?

2.

What is the federal deficit?

3.

How does the government borrow money?

4.

What are treasury bills?

5.

Who determines what the prime interest rate will be?

6.

Who lends money to the federal government?

7.

What determines how much is borrowed?

8.

What is NET DEBT?

9.

What does fiscal mean?

10.

Do other Western Countries have large national debts?

11.

What are the primary problems caused by the national debt?

12.

What percentage of federal income each year goes to interest on the national debt?

13.

What two categories of spending are larger than the interest on the debt?

14.

What would have to be done to reduce the national debt?

15.

What are entitlements and why are they so difficult to cut?
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Virtual Economics Activity for Monetary Policy
Navigation
Click once on Resource Button
Click once on Curriculum Materials 9-12
Click once on Document Titles
Locate and click once on Who We Are & What We Do: The Federal Reserve System
Speed read through the document using the scroll bar.
Answer the following questions
1.

How many district banks make up the Federal Reserve?

2.

What is the Term Limit for the seven members of the Board of Governors?

3.

What types of banks are required to be members of the Federal Reserve System?

4.

What services are offered by the Federal Reserve System?

5.

What is monetary policy?

6.

How is monetary policy formulated?

7.

How does the Federal Reserve System (FED) transfer funds electronically?

8.

What are Automated Clearing Houses?

9.

What type of credit does the FED make to depositors (member banks)?

10.

How does the FED help finance the national debt?

Power Point
Presentation
Software

**Power Point**
Microsoft Power Point for Windows is a presentation program that allows you to create and present slides. It has
many options which include:
-Drawing tools which can be used to make shapes
-A word processor with a spell check
-A Toolbar for access to commonly used functions
-A graphing feature
-A thorough Help function
-Many different templates which are easy to use
-Full color options
-Many clip art options
-Special effects which can enhance your presentation.

Organization and Considerations
Double click on the Power Point icon.
2>

The program may open with tips about Power Point. Read the tip and then click on O.K. You will
now be presented with the following options.
Auto Content Wizard-Power Point will walk you through the initial steps of
deciding what the standard items of the presentation will be.
Pick a Look Wizard-You will be able to select a particular template and then,
based on your decisions, Power Point will create the presentation for you.
Template-Pre-designed styles which can be changed and customized.

Blank Presentation-Blank background where colors and items can be added.

Open an Existing Presentation
Click on Blank Presentation and then O.K.
3>

You now have the option of picking a layout which will work for your objectives. In this case move to
the layout with a title area and three bullets. Click on O.K.

4>

Click in the title space. Enter a "Power Point Presentation".

5>

Click in the body. Enter "Planning" and hit enter. Notice how it automatically creates bullets. You
should enter the other two steps in putting together a presentation and they are "Creating" and
"Presenting".

6>

You now have your first slide, to view it click on View and then Slide Show from the menu bar. A
menu will pop up and you should click on Show. You are now looking at your first slide. A click on
the mouse will return you to the main program. A quicker way to view your slide is to click on the
Slide Show Button at the bottom of the screen.
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7>

You can now create your second slide. Click on Insert and then on New Slide, once again you will
be able to pick a layout. In this case scroll down until you find the blank slide format and pick this
one.

8>

We will put a graphic into this slide, it will be your choice as to which one to use but it should tie in
with the process of creating a slide show. Find the Insert Clip Art Button on the menu bar and
click on it or click on Insert and then on Clip Art. Pick a graphic and click on O.K. This will put
the graphic into your second slide.

9>

Click on the graphic and the handles will appear, use them to move and size it accordingly.

10>

You have now created two slides, to view them both click on the Slide Sorter View Button at the
bottom on the screen or click on View and then Slide Sorter from the menu bar.
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Tool bars:
Below are pictures of the icons from the toolbars that you will be using.
1 NI,
'1 '11r
Buttons on PowerPoint's Standard Toolbar (continued)

Buttons on PowerPoint's Standard Toolbar
New: Creates new presentation. (File > New] Shortcut Cul+-N

Insert Org Chart Creates an org-chart object (Insert > Object
> Microsoft Organization Chart]

Open: Opens existing preientations. (File > Open] Shortcut

Ctr1+0

Insert Clip Arc Opens the ClipArt Gallery. (Insert > Clip Art]

Save: Saves current presentation. (Pie > Save] Shortcut Ctri:1

Pick A Look Wizard: Runs the Pick A Look Wizard.

(Format > Pick A Look Wizard]
Print Prints single copy of slides (does not bring up Print
dialog box).
Spelling: Runs the spelling checker. Fools > Spelling] Shortcut F7

Cuc Cuts selected item(s). (Edit > Cut] Shortcut Ctr1+X

Report It Saves slides as a Word outline sans grapnics.

Help: Click then point to item of interest for online help.

Li

Buttons on PowerPoint's Drawing Toolbar

Copy: Copies selected item(s). (Edit > Copy] Short= Ctrl -t
Selection: Click on objects while thii button is depressed.
Paste: Pastes from Clipboard. (Edit > Paste] Shortcut Cp-iv

Text Drag with this button depressed to create text objects.
Format Painter: Copies then applies format of selected item. Not
for graphics or pictures.

.

Line: Use to draw lines
Rectangle: Use to draw rectangles.

Undo: Performs a single undo no list). (Edit > Undo] Shortcut

Ctrl+Z
Ellipse: Use to draw circles and ellipses.

Insert New Slide: Inserts a new slide after current slide. (Insert 0
New Slice] Shortcut Ctri+M

O

Arc Use to draw arcs.
Freeform: Use to draw freeform shapes.

Insert Microsoft Word Table: Inserts a Word table. (Insert >
Microsoft Tabie]

Free Rotate: Use to rotate selected drawn objects.
Insert Microsoft Excel worksheet Inserts an Excel NOritItlEft

aurrora

(not a work000ki.

Autoshapes: Reveals tear -off AutoShaoe palette.

insert Gratin: Creates a Graph abject (Insert > Microsoft
Graph]

Fill 0,110,1: Turns automatic drawing

ozscnumaes

BUTTON

Buttons on PowerPoint's Outline Toolbar (continued)
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LII

DESCRIPTION

Buttons on PowerPoint's Drawing Toolbar (continued)

Move Down: Places selected text nearer to the bottom of your

a

Collapse Selection: Hides all but slide tide for selected slides.
Alt+Shift+minus

0

on or of. `Niel add or

remove fill from an existing object

Expand Selection: Shows all text and headings in selected slides.

Alt"-Shift.plus

line On/Off:Applies the default line style to an object or
removes the line.
Shadow OniOff: Adds or removes shadow effects from selected

objets.
Buttons on PowerPoint's Slide Sorter Toolbar

Show lides: Shows tides only. Shortcut Alt-Shift+ L.

Transition: Opens Transition dialog box. (Tools > Transition]

Show All: Shows all text and headings. Shortcut AltShift.A

Build: Opens Build dialog box. (Tools > Build]

Show Formatting: Displays and hides text formatting (bold.
italic. etc).

Hide Slide: Hides current slide. (Tools > Hide Slide]

PowerPoint's Slide Show Toolbar

2
1.12

Drawing:Turns on-screen drawing on and off.

Rehearse Timings:: Times rehersals and shows umes on-screen.

(View > Slide Show]
Show/Hide Formatting:In Outline view, this toggles display of
character formatting (bold. italic. etc).

PowerPoint's Formatting Toolbar

Buttons on PowerPoint's Oudine Toolbar

Increase Font Size

Promote (Indent Less): Moves item up one level in outline.

Dec-ease Font Size

Shortcut Ctr1+.
Demote (Indent More): Moves item down one level in outline.
Shortcut Ctr1+--

Bold

BEST COPY AVAILAIBLE7o
Italic

Move Up: Places selected text nearer to the beginning of your

ouoine.Alt.-Shtft+-
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BUTTON

DESCRIPTION

Power Point's Formatting Toolbar (continued)
Unaeriine

Text Shadow

Text Color

Left Alignment

Center Alignment

Bullets On/Cff

Promote Ilncent Less I

Demote I Indent Morel

More Advanced Features:
You have just created a two-slide, blank presentation. You will now learn how to add more
advanced features such as background templates and adding slide show effects.

To apply a template to a new presentation:
1.

2.
3.
4.

Create a new presentation.
Choose Template from the Welcome window.
Select the desired template.
Choose Apply.

To apply a template to an existing presentation:
1.

Open an existing presentation.

2.
3.
4.

Click on the status bar Template button or choose Format, Presentation Template.
Select the desired template.
Choose Apply.

To add transition effects in Slide Sorter view:
1.

2.
3.
4.

Open the desired presentation and display Slide Sorter view.
Select the slide to contain the transition effect.
Click on the Slide Sorter toolbar Transition Effects drop-down arrow.
Select the desired transition.

BEST COPY MLA

1,1

0.)

LE

71

99

To add transition effects, timing, and speed in all views:
1.

2.
3.
4.
5.

6.
7.
8.

9.

Open the desired presentation.
Select or display the slide to contain the transition effect.
Choose Tools, Transition.
Click on the drop-down arrow beside the Effect text box.
Select the desired effect.
Select the desired speed for the transition.
Select the desired advance method.
Type the number of seconds to display the slide if you choose automatic advance.
Choose OK.
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Power Point Activity
Directions: Create a Power Point slide show using the topic "Types of Business
Ownership". Use at least one clip art in your slide show. Use the following
information for your slide show:

Business Ownership
Forms of Business Ownership
-Sole Proprietorship

-Partnership
-Corporation
-Franchise
-Cooperative

Sole Proprietorship
-Easy to start and operate.
-Owner makes all the decisions and earns all the profits.
-May have difficulty raising capital.
'Unlimited liability.

Partnership
-Fairly easy to set up and operate.

-Partners can raise capital more easily than sole proprietors, and they share profits.
-Unlimited liability.

-Partners may disagree.

73
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Corporation
'Complex and expensive to set up.

'Separate legal existence.

'The investors' liability is limited
'Capital and financing are easy to obtain.
'Higher tax rate.

Franchise
Can start a business and get help from the parent company in return for paying the parent
certain fees.
'Must pay a share of the sales or a yearly set fee to the parent company.

May have to spend a fairly large amount of money to purchase the franchise.

Cooperative
-Owned, and in many cases, operated by its members.

Not set up to make a profit.
-Set up so the members get the best prices.

BEST COPY AVAILABLE
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Appendix 1

WWW RESOURCES
for
THE STOCK MARKET GAME
and
COMMODITY CHALLENGE
When entering the WWW addresses it is often not necessary to enter the prefix
http://. You can often simply start with www in the location box.

http://pawws.secapl.com/smg2000/
SMG 2000, The Stock Market Game.
http://www.lehigh. edu/-1 p f5/quote. htm I
Very good for finding stock symbols, stock prices and definitions.

http://www.newspage.com/NEWSPAGE/stockquotes.html
Very good for finding stock symbols, stock prices and stock charts.
http://wwvv .cbot.com/
The Chicago Board of Trade. Good access to commodity prices.

http://www.primenet.conildocw/index.html
Discussion on how to approach investing. Click on the Making Money link.

http://investorweb.com/begin.htm
Very good investment advice for the novice investor.

There are many other related sites on the Web as well as the ones listed above. You
can search for them by using the key words; Stock Quotes, Stocks, Exchanges,
Investing, Investment Advice, Commodities, etc.

OTHER RELATED SITES:
http://www.nyse.com
http://www.amex.com
http://www.nasdaq.com

1
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University of Idaho
Division of Adult, Counselor, and Technology Education

Multi-Media and Technology Tools:
Curriculum and Activities for
Business Teachers
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Economics/Consumer
BEST COPY AVAILABLE

Education-Trends and Issues .................. 19

Downloading.............. .............................15

Shareware

Netscape Navigator
Directory of WWW Sites

Computer Use Policy
Multimedia Fact Sheet

Introduction
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University of Idaho Home Page
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What's New

Search
Help

UI Computer Use Policy

Misc. Page

UI Anonymous FTP Server

Search

Under the Logo
The Copyright Page
The University of Idaho
Guest Book
UI Web Server Statistics
The UI Web Team
Styles Guide
Local Internet Services

Search content of Department and
Group pages
Master Department Directory
(Departmental Phone,Zip,Email,Fax)
Personal Email address and Phone
numbers (CSO Database)
Personal Home pages

FAQ
Contacting Webhelp
Help Desk
Home page development
CGI programs @ Idaho

o Staff pages
o Faculty pages
o Student pages

°

General Catalog
Graduate Catalog
UI Library Search
Faculty Staff hand book
Gobal Search Tools

11/20/96 2:59 PM
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http://www.jumbo.com/

SHAREWARE! GAMES! FREEWARE! - JUMBO!

TM

What We've Got!
What's New

Over 74,000 Shareware & Freeware Programs!

Count 'em! 74,003

To DowroIoads

FREE! FREE! FREE!
F./gLonaGlted.

Products

SHAREWARE & FREEWARE CATEGORIES:

ACTIVEX

JAVA

Authoring Tools, Controls, VRML

Games, Source Code, Applets

0 BUSINESS

MULTIMEDIA
Animations, Audio, Graphics

Spreadsheets, Database, Finance

WebMaster Tailks

Starter 13ts

0 DESKTOP

PLUG-IN PLACE

Graphic, Icons, Conversion

Plug-ins For Your Browsers!!

EDUCATION

PROGRAMMING

Vocabulary, Tutors, Languages

Modules, Code Editors, Kits

SCIENCE

CD GAMES
3D, WAR, Adventure, Quake

Space, Chemistry, Biology

OD HOBBIES a HOME

UPDATE CENTRAL

Astrology, Gardening, Health

Patches, Drivers, Upgrades

0 INTERNET a www

UTILITIES

Browsers, Email, I-. IP

Compression, Archiving, Zip

SEARCH WORDS:

COMING SOON:
Go!!

Quake

ADVANCED SEARCH

1 of 3

Chat
Fun for Kids!!!
Personal Digital Assistants

11/21/96 10:13 AM
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http://www.webcom.comk-piper/state/states.html

State and Local Government on the Net

on tin Net

ocall G©v
Table of Contents
The FAQ
Add a Link
Search
Your Comments

Quick search:

,..Submit
----

ti

Hint: Simple keyword searches work best! For more complex
searches, see the search page.

The Publisher
The PIPER Letter

Alabama (11/17)
Alaska (11/17)
Arizona (1.1/2)
Arkansas (11/17)
r, ifornia (11/17)
Colorado (11/4)
Co necticut (11/17)
Delaware
District of Columbia (11/17)
Florida (I 1 ill)
1/2)
Georgia
Hawaii (11/2)

Idaho
Illinois (11/2)
Indiana (11 /4)
Iowa (11/17)
Kansas (11/17)
Kentucky (11/2)
Louisiana (11/17)

Maine
Maryland (11/4)
Massachusetts (11/17)
Michigan (11/17)
nesota (11/17)
EiliminiBai (11/17)
Missouri (11/2)
Montana.

Nebraska
Nevada

New an shire (11/2)
New Jersey (11/17)
New Mexico (11/17)
New York (11/17)
North Carolina (11/17)
North Dakota (11/2)
Ohio (11/17)

11/21/96 10:31 AM
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http://www.doe.state.id.us/

IDAHO Works
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Idaho Department of Labor
0 0 Click Here to Display MAIN MENU 0 0

Idaho's Work Force Development System

The Idaho Department of Labor is part of Idaho's Work Force Development System,
a collaboration of state and local agencies dedicated to the creation of a globally
competitive work force in Idaho. The Department created and maintains Idaho
Works, the information system for Work Force Development. The Department is
also Idaho's part of a national labor exchange system referred to as the Job Service.
The primary function of the Job Service is to match job seekers with prospective
employers. The Department maintains this page on the World Wide Web to assist in
these efforts.
0 0 MAIN MENU 0 0
Click on the capitalized portion of the following to make a selection:
GI Getting started / Office directory. GENERAL INIFOR1W.ATION

0 Information about the job market. LABOR MARKET INFORMATION

0 Jobs available. JO SEA CH
0 Training available. JO TRAINING
()Information on Unemployment Insurance. UNEMPLOYMENT INSURANCE
ANK
()US Department Of Labor. AMERICA'S JO
0 Other State Employment Services. JO IL SERVICES
0 Other services. OTHER HELP
()Migrant & Seasonal Farmworker Information Exchange. MSFW
0 State of Idaho. HOME PAGE

Idaho Department Of Labor

11/21/96 10:33 AM
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